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Getting Started

This chapter describes the features, architecture, and

installation of Autodesk MapGuide® Provider for SHP.
Provider for SHP is a Microsoft® OLE DB data provider
that serves spatial and attribute data from an Environ-
mental Systems Research Institute (ESRI®) SHP (shape

file) data source to Autodesk MapGuide users.

M
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In this chapter

About this document

Overview of Provider for
SHP

System requirements
Installation

Checking the installation
Removing the installation

Updating, repairing, or
removing the installation



About This Document
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This document is written for system administrators who install Autodesk
MapGuide Provider for SHP, and manage its operations and for developers of
Web sites that provide access to Autodesk MapGuide maps. The document
provides details about the following topics:

m The features and software requirements of Provider for SHP

Installing and configuring the Provider for SHP configuration files.

How to get started using Provider for SHP

The mapping of SHP geometry to Autodesk MapGuide geometry, which
accounts for the minor differences in appearance of maps in the SHP and
MWEFE file formats

m Finding a coordinate system used in Autodesk MapGuide Author that is
equivalent to the ESRI coordinate system used in a SHP file

Documentation Conventions and Assumptions

In this document, a coordinate system used in Autodesk MapGuide Author
is called an MWF coordinate system, and the terms coordinate system and
spatial reference system (SRS) are synonymous.

This document assumes that you know how to create maps using Autodesk
MapGuide Author, understand how to assign MWF coordinate systems to
maps, and have read the Autodesk MapGuide User’s Guide and Autodesk
MapGuide Help.

Copying Text from This Document

You can copy text from this PDF file and paste it into another application.
For example, you may want to copy code samples for use in your own work.
To copy text from a PDF file

1 Click the Text Select tool on the Acrobat Reader toolbar.
2 Drag to select the text you want to copy.
3 Right-click and choose Copy from the shortcut menu.

The text is copied to the Clipboard.

Chapter |  Getting Started



Overview of Provider for SHP

Data Providers

Data

Provider for SHP adds the capability to Autodesk MapGuide® Server to serve
data from ArcView® and ArcInfo® products, which are in SHP format. You do
not have to convert SHP files to the SDF (spatial data file) format before using
SHP files with Autodesk MapGuide® Author. The data served by Autodesk
MapGuide Server with Provider for SHP follows the OpenGIS Simple Features
specification for a COM/OLE component. Autodesk MapGuide Server is able
to access data from SHP, SDF, Oracle8i™ Spatial and Oracle9i™ Spatial, and
other OLE DB data provider components known as Spatial Data Providers
(SDP), as shown in the following diagram.

Autodesk MapGuide Server

Autodesk MapGuide Autodesk MapGuide Autodesk MapGuide
Provider for SDF Provider for SHP Provider for Oracle Spatial

Spatial

Provider for SHP is a member of the family of OLE DB providers to Autodesk MapGuide Server.

Through Provider for SHP, Autodesk MapGuide Server can access native SHP
data sources. You do not have to convert the SHP files to the Autodesk
MapGuide Spatial Data Format (SDF) or to any other format before using
them in Autodesk MapGuide Author.

A SHP file, as referred to in this document, actually consists of three separate
files: SHP (shape geometry), SHX (shape index), and DBF (shape attributes in
dBASE format). Provider for SHP accesses the information in each of these
files and treats each SHP and associated DBF file as a feature table with a
single geometry column and optionally, with attribute columns.

Overview of Provider for SHP | 9



Features

Using the standardized data access architecture of Provider for SHP, map
authors can perform the following tasks:

m Access SHP files with no translation of source data
m Establish Zoom Goto categories that use SHP spatial data sources

m Create theme categories from SHP spatial data sources

Advantages over SDF Loader

Provider for SHP eliminates the need to convert SHP data from ArcView and
ArcInfo products to SDF (spatial data file) before using it with Autodesk
MapGuide.

Using Provider for SHP instead of SDF Loader cuts the number of files you
have to manage in half. You manage one set of SHP files instead of managing
both SHP and corresponding SDF files.

Geometries rendered by Provider for SHP look the same as geometries from a
corresponding SDF file.

System Requirements

This section describes the hardware, software, and operating system require-
ments of Provider for SHP.

Required Hardware

m 128 MB of RAM (minimum)
m 25 MB free hard disk space (minimum) plus space for data

10 | Chapter | Getting Started



Supported Platforms

You can install Autodesk MapGuide Server and Provider for SHP and on
Windows® 2000 Server SP1 or SP2 (SP2 recommended or on Windows NT 4.0
SP4-6a (SP6a recommended).

Required Software

The following software, not included with Provider for SHP, must be installed
on the server before installing Provider for SHP:

m MDAC/OLE DB 2.5 SP1 or later (Windows NT only)—Microsoft® Data
Access Components (MDAC) establish a connection to the OLE DB data
source, which is the SHP repository. MDAC 2.5 SP1 is a component of the
Windows 2000 operating system, and it is available as a stand-alone dis-
tribution program for Windows NT 4.0 that you can download from the
Web. MDAC is also included on the Autodesk MapGuide Release 6 CD.

Note MDAC 2.6 RTM no longer includes Microsoft Jet 4.0 support. If you
install MDAC 2.6 RTM or later, you might need to install Microsoft Jet 4.0 SP5
if you require this functionality for use with Provider for SHP.

m Autodesk MapGuide Server Release 6 or later—Install and authorize
Autodesk MapGuide Server before installing Provider for SHP. Provider for
SHP does not function with versions earlier than Autodesk MapGuide
Server Release 6.

m Web Server—Ensure that Microsoft® Internet Information Server (IIS) 4.0
or later, or Netscape® Enterprise Server 3.6 or later, or iPlanet Web Server
Enterprise Edition 4.1 is installed and properly configured.

System Requirements | 11



The following system architecture diagram shows the major components
required for use with Provider for SHP.

Web Browser

Autodesk MapGuide Viewer Autodesk MapGuide
Author

Server

‘ Web Server ‘
SHP
data

‘ Autodesk MapGuide Server ‘

OLE DB

Provider for SHP

Windows Server

SHP
data

Provider for SHP serves local or remote SHP data through a Web server to authors and viewers.

Installation

You need one or more locations of SHP files before you begin the installation.
Provider for SHP searches for the SHP files in the locations you specify.

Note To install Provider for SHP, you must be logged on as Administrator or as
a user who is a member of the Administrators group.

If you do not have administrative rights to the computer, you cannot
complete the installation.

To install Provider for SHP

1 Ensure that Autodesk MapGuide Server is installed, authorized, and func-
tioning properly. For more information about installing Autodesk
MapGuide Server, refer to the Autodesk MapGuide User’s Guide.

Do not use an evaluation or Beta version of Autodesk MapGuide Server.
You cannot install Provider for SHP unless you are running an authorized
version of Autodesk MapGuide Server.
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2 Inform users to discontinue use of the Autodesk MapGuide Server Service
until you complete the installation.

The setup program stops Autodesk MapGuide Server Service during instal-
lation, and restarts it after completing installation.
3 Insert the Autodesk MapGuide Release 6 CD into the CD-ROM drive. An
installation dialog box showing the following options is displayed:
m Server Products
m Author Products
m Viewer Products
m Third-Party Products

Note If the installation dialog box is not displayed, double-click the setup.exe
file on the Autodesk MapGuide Release 6 CD.

4 Click Autodesk MapGuide Server Products.
The Server Products installation options are displayed.

5 Click Provider for SHP.

6 Follow on-screen instructions to install Provider for SHP until you see the
following dialog box for entering the SHP search path.

f5 Autodesk MapGuide[R) Data Extension for SHP Setup H= 3=

Configuring Autodesk MapGuide Data Extension for SHP
Set pour Autodesk MapGuide D ata Extenzion for SHP search path.

SHP Search Path:

*r'ou may enter multiple path names separated by semi-colons
[e.g. CASHP.C:AData SHP MM achineM amelSHP).

To continue, click Next.

<Back I Mext> I Cancel |

The SHP search path is one or more path names of the directories where
SHP files reside.

Installation 13
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7 Enter the path or paths to the SHP files that you want users to access. You
will be able to change or add paths to the SHP search path after installa-
tion, if necessary.

Chapter |

Follow these rules for specifying the SHP search path:

Use only full, local, or Universal Naming Convention (UNC) paths. Rel-
ative paths are not supported.

Do not use HTTP links in the path.
Separate multiple paths with semicolons.
Do not put spaces before or after semicolons.

If a path contains one or more semicolons, enclose the entire path in
quotation marks. For example,

D:\SHP;”D:\SHP\Belgium;Antwerp”;E:\SHP
If your SHP files reside on different servers, extend the SHP search path

to search multiple physical locations by appending the paths of these
locations to the SHP search path. For example,

\\MyServer\Maps,;C:\Autodesk MapGuide\shp files;d:\temp;

To access SHP files on other machines on your network, Autodesk
MapGuide Service must be running under a user account. For information
about running Autodesk MapGuide Service under a user account, refer to
“Configuring Autodesk MapGuide Server under a Different Account” in
the Autodesk MapGuide User’s Guide.

Continue following on-screen instructions until you finish the
installation.

Getting Started



Checking the Installation

Default SHP:

You can check that Provider for SHP was installed using the procedure in this
section.

To check the installation

1 Start Autodesk MapGuide Server Service if it is not running.
2 In Autodesk MapGuide Server Admin, choose Edit » Properties.
3 Click the Data Sources tab.

The list of data sources and the data source search path is displayed.

Properties [ %]
General Data Sources | Loggingl Users.-"GroupsI Hesourcesl Access Ke_l,lsl
Data sources:
Mame Available Mew...

S ample_‘world_DE
S ample_\world_SDF

data source

SHP

Hﬂﬂi

Eename... |
Delete |

Data zource search path:

E:\Program FilegAutodesk\M apGuideServerBiD ata Sources

QK | Cancel | Lpply | Help |

4 Check for the presence of the default SHP data source, SHP.

If you see it in the list of data sources, the installation succeeded.

Note If you do not have SHP files in the locations specified by the SHP search
path, Provider for SHP cannot create the data source.

5 Click OK in the Properties dialog box.

Checking the Installation | 15



Removing the Installation

Use the Add/Remove button on the Add/Remove Programs control panel to
remove Provider for SHP. You can also use the Autodesk MapGuide Release 6
CD to remove the installation. Removing the installation includes removing
registry entries and shortcuts.

Note To remove the Provider for SHP installation, you must be logged on as
Administrator or as a user who is a member of the Administrators group.
To remove the installation

1 Inform Autodesk MapGuide users to discontinue use of the Autodesk
MapGuide Server Service until you complete the changes.

2 Double-click Add/Remove Programs in the Control Panel.
The launch screen is displayed.

3 TFollow on-screen instructions to remove Provider for SHP.

Updating or Repairing the Installation

16

When you update or repair the installation, the install program reinstalls all
of Provider for SHP files according to their configuration during the initial
install. If an older or missing file is detected on the system, the install
program reinstalls the files and overwrites shortcuts.

To update or repair Provider for SHP, you need to use the Autodesk
MapGuide Release 6 CD. Do not use the Add/Remove Programs control
panel. Follow these steps to upgrade or repair the installation:

Note To update or repair the installation, you must be logged on as Administra-
tor or as a user who is a member of the Administrators group.

Chapter |  Getting Started



To update or repair the installation

1

Inform Autodesk MapGuide users to discontinue use of the Autodesk
MapGuide Server Service until you complete the changes.

Insert the Autodesk MapGuide Release 6 CD into the CD-ROM drive. An
installation dialog box should be displayed. If it is not, double-click the
setup.exe file on the Autodesk MapGuide Release 6 CD.

Click Autodesk MapGuide Server Products.

The Server Products installation options are displayed.
Click Provider for SHP.

The Welcome screen for Provider for SHP is displayed.

f5 Autodesk MapGuide{R) Data Extension for SHP Releasze 6 Setup

Welcome
‘Welcome to the Autodesk MapGuide D ata Extengion for SHP Setup wizard.

An existing installation of Autodesk MapGuide Data Extengion for SHP haz been detected.
“f'ou car:

& Update or repair files
Fieingtallz any files that have changed since you last installed this release of Autodesk
MapGuide D ata Extension for SHP. Use thiz option if you have received an updated

Autodesk MapGuide Data Extension for SHP or if any of vour installed files have been
corupted.

" Remove Autodesk MapGuide Data Extension for SHP

Femoves Autodesk MapGuide D ata Estenzion for SHP and its supporting files and
registry entries.

To continue, click Next.

Cancel |

4 Follow on-screen instructions to update or repair Provider for SHP.

Updating or Repairing the Installation

17
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Configuring Provider for SHP

This chapter describes the default SHP data source that
Autodesk MapGuide® Server creates at installation time
when you set the search path to SHP files. After installa-
tion, you create additional data sources to establish more
OLE DB connections from Autodesk MapGuide Server to

Provider for SHP.

In this chapter

Configuration tasks

Changing the SHP search
path

Matching the SHP and MWF
coordinate systems

Specifying the coordinate
system

Creating data sources

19



Configuration Tasks

20

This section briefly describes the configuration tasks that you perform.

m Changing the SHP search path (optional)—When you install Provider

for SHP, an OLE DB data source link is created. The default name of the
data source is SHP. This task involves changing the default data source
search path and creating additional data sources.

Matching the SHP and MWF coordinate systems—You must find the
MWF coordinate system that corresponds to the coordinate system in
which the SHP maps were authored, then you can specify that coordinate
system when you perform the next task. If no MWF coordinate system
matches the coordinate system of the SHP map, you must create a SHP file
that uses a matching coordinate system. You can do this by reprojecting
the coordinates in the SHP map using the ArcView® GIS Projection Utility.
The ArcView GIS Projection Utility is included with ArcView GIS 3.2 and
is available on Microsoft® Windows® platforms. For more information
about the ArcView GIS Projection Utility, go to the following Web site:

http:\ \www.esri.com

For more information about coordinate systems, choose Help » Contents
in Autodesk MapGuide Author, click the Index tab, and look up “coordi-
nate systems, about.”

Specifying the coordinate system of the SHP data source—You perform
this task before using the default data source. The data source contains
only the location of the SHP files, and no coordinate system information.
You need to specify the coordinate system in which a SHP map was saved
when it was authored before using the default SHP data source.

Creating additional links to SHP data sources—Performing this task sets
up data sources for SHP files in addition to the default data source. By set-
ting up multiple data sources, you can use SHP maps, which are authored
in different coordinate systems, in the same MWE.

Chapter 2 Configuring Provider for SHP



Changing the SHP Search Path

The SHP search path is one or more paths where the SHP files reside. During
installation, you specified the SHP search path. To change or to add directo-
ries to the SHP search path after installation, follow these steps.

To change the SHP search path

1 In Autodesk MapGuide Server Admin, choose Edit » Properties and click
the Data Sources tab in the Properties dialog box.

The Data Sources tab displays the data sources and their availability.

Properties [ %]

General Data Sources | Loggingl Users.-"GroupsI Hesourcesl Access Ke_l,lsl

Data sources:

Mame Available Mew..

S ample_‘world_DE
S ample_\world_SDF
SHP

Hﬂﬂi

Eename... |
Delete |

Data zource search path:
E:\Program FilegAutodesk\M apGuideServerBiD ata Sources

QK | Cancel | Lpply | Help

2 Select the SHP data source in the list of data sources.
3 Click Properties.
The Data Link Properties dialog box is displayed.

4 Click the Connection tab.

Changing the SHP Search Path | 21



The Connection tab of the Data Link Properties dialog box displays the
Search Path text box.

B3 Data Link Properties k [ %]
Frovider - Cannection |Advanced| Al I

Specify the following to connect to this data:
1. Enter the SHP Search path:
Search Path: ID:\ShpFiIes

Maote: Multiple paths need to be delimited by the ' character.
Example: C:ASHPs:D:ASHPs

QK | Cancel | Help |

5 Enter the SHP search path according to the rules for specifying the path
on page 14.

6 Click OK to close the Data Link Properties dialog box.

Matching the SHP and MWF Coordinate
Systems

You must find the MWF coordinate system that corresponds to the coordi-
nate system of the SHP files before using the default SHP data source and also
when you create additional data sources. If you don’t know the coordinate
system in which the SHP map was created, open the associated PR] file using
a text editor, and look for the coordinate system information. If you don't
have a PRJ file, use an ESRI product to open the SHP map and identify the
coordinate system. Find the name of the MWF coordinate system that corre-
sponds to the SHP coordinate system. If there is no corresponding coordinate
system, see “Coordinate System Mismatch” on page 62.

22 | Chapter 2 Configuring Provider for SHP



There are several ways to find the name of the MWF coordinate system that
corresponds to a SHP coordinate system:

m See Appendix A, “Matching SHP and MWF Coordinate Systems” on page
69, to find the name of the MWF coordinate system that corresponds to a
SHP coordinate system. You can use Appendix A to find coordinate system
codes in the following categories only:

m Australia

Indonesia

New Zealand

State Plane NAD 1927

State Plane NAD 1983

State Plane NAD 1983 (Feet)
UTM WGS 1984

World

m Refer to the coordinate description file that is installed with SDF Loader.
The default path and name of the file is:

Program Files\Autodesk\MapGuideSDFLoader6\cscodes.txt

Look for a name in this file that resembles the name of the SHP coordinate
system. For example, the SHP coordinate system AGD 1966 AMG Zone 49
corresponds to the first MWF coordinate system under [Australia],
AMG66-49 = Australian Map Grid Zone 49, using AGD66 Datum, as
shown in the following illustration of the cscodes.txt file.

E cscodes.txt - Notepad [_ (O] %]
File Edit Search Help
34d39') North |
ALG-29 = Algerie, west of 6 deqg W, Z2one 29 Horth, Heter P |
ALG-38 = Algerie, 6 deg W to @ deqg W, Z2one 38 Horth, Heter
ALG-31 = Algerie, @ deg E to 6 deq E, 2one 31 Horth, Heter
ALG-32 = Algerie, east of 6 deq E, 2one 32 Horth, Heter
[Argentina]
FAJA-1 = Argentina, Gauss Krugger Faja 1
FAJA-2 = Argentina, Gauss Krugger Faja 2
FAJA-3 = Argentina, Gauss Krugger Faja 3
FAJA-4 = Argentina, Gauss Krugger Faja &4
FAJA-5S = Argentina, Gauss Krugger Faja 5
FAJA-6 = Argentina, Gauss Krugger Faja 6
FAJA-7 = Argentina, Gauss Krugger Faja 7
[Australia
= Australian Map Grid Zone 49, using AGDG6 Datu
AMG66-58 = fAustralian Map Grid Zone 58, using AGDG6 Datum
AMG66-51 = Australian Map Grid Z2one 51, using AGDG66 Datum [~

m Use Autodesk MapGuide Author to find the name of the MWF coordinate
system that corresponds to a SHP coordinate system.

Matching the SHP and MWF Coordinate Systems | 23



To find an MWF coordinate system that matches a SHP coordinate system
1 In Autodesk MapGuide Author, choose File » New.
The default World Countries sample map is displayed.

2 Right-click in the map to display the Map Window popup menu and
choose Properties.

The Map Window Properties dialog box is displayed.

General | Coardinate Systeml Heportsl Zoom Gotol Fopup Menul Securityl

Mame: Background color:

ap1

— Center and size Wiew distance function
Latitude: Longitude: # Euclidean
|0.000000 = |o.000000 =
" Great Circle
‘width [DEGREE]: Height [DEGREE]:
[375 = [z =
Take Center and Size from Current Zoom | APl Symbols. .. |

QK I Cancel Help |

3 On the Coordinate System tab, click Change.

4 Select a category from the Category list that resembles the name of the
SHP coordinate system.
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The Change Map Window Coordinate System dialog box is displayed
showing the list of categories.

Change Map Window Coordinate System [ %]

Arbitrary ¥ Coordinates [Centimeters]

Arbitrary %7 Coordinates [Kilometers]

Arbitrary %7 Coordinates [Englizh vards]

Arbitrary % Coordinates [Sears Yards)

Arbitrary %7 Coordinates (US Survey Mileg]

Arbitrary %7 Coordinates (International v'ards] LI
Arhitran % Conrdinates nbarnatinnal biles]

5 Click a coordinate system in the Available Coordinate Systems list that
resembles the name of the SHP coordinate system.

6 Click OK.

The Map Window Properties dialog box is displayed showing the coordi-
nate system value in the Code text box. Use this code to specify the MWF
coordinate system when you configure the default data source for SHP or
create additional data sources.

Map Window Properties [ %]

General Coordinate System | Heportsl Zoom Gotol Fopup Menul Securityl

Code: I"XY-FT"

Categony: IArbitrary % Coordinate Systems
Description: IArbitrary #7 Coordinates [US Survey Feet]
Projection: IArbitrary #1 Coordinate Projection

D atumn: IND D atum Uszed

QK Cancel Help

7 Click Cancel.
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If you don’t find the name of an MWF coordinate system that corresponds
to the coordinate system of your SHP file, use the ArcView GIS Projection
Utility to change the coordinate system of your SHP file to one for which
there is a match.

Specifying the Coordinate System

26

The default data source that you create when you install Provider for SHP
includes the location of the SHP files that you entered during installation,
but no coordinate system information. The SHP map might contain data for
the same area in space as the other data in the Autodesk MapGuide Author
project, but the SHP data might be represented in a different coordinate
system.

Autodesk MapGuide Server needs to know the coordinate system in which
the SHP file was saved to ensure that the coordinate system of the MWF
matches, so that entities appear in the right place when the SHP file is
opened in Autodesk MapGuide Author. If you don't specify the coordinate
system in which your SHP files were saved, the default Autodesk MapGuide
Author coordinate system, the LL84 coordinate system, is used.

To specify coordinate system information

1 Open Autodesk MapGuide Server Admin.
2 Choose Edit » Properties.
The Properties dialog box is displayed.

3 Click the Data Sources tab, and select the default SHP data source.
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Default SHP
data source

The Data Sources tab displays the data sources and their availability.

Data sources:

General Data Sources | Loggingl Users.-"GroupsI Hesourcesl Access Ke_l,lsl

Properties [ %]

Mame

S ample_‘world_DE
S ample_\world_SDF

SHP

Data zource search path:

Available

Hﬂﬂi

Eename... |
Delete |

E:\Program FilegAutodesk\M apGuideServerBiD ata Sources

Cancel Lpply Help

4 Click Properties.

The Data Link Properties dialog box is displayed.

B3 Data Link Properti I

Frawider | Eonnectionl Advancedl Al I

Select the data you want to connect to:

| OLE DE Froviderfs)

Autodesk, Spatial D ata Pr

Connectivity Service Provider

Microsoft Jet 3.51 OLE DB Provider

Microsaft Jet 4.0 OLE DB Provider

Microzoft OLE DB Provider for Intemet Publishing
Microsoft OLE DB Provider for Microsoft Index Server
Microsoft OLE DB Provider for Microsoft Site Server Search
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for OLAP Services
Microsoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for SOL Server

Microzoft OLE DE Simple Provider

M5 Remate

MSDataShape

Met Library Collator

OLE DB Provider for Microsoft Directory Services

Mext »» |

QK I Cancel | Help
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5 Click the Advanced tab, and then, using one of the following ways, specity
the coordinate system in which the SHP files are stored:

m Select a Category for the coordinate system to be used for this data
source.

m From the SRS list, select the MWF coordinate system that corresponds
to the SHP coordinate system.

The Category and SRS lists are displayed.

B3 Data Link Properties [ %]
Providerl Connection  Advanced |AII I
— Default SRS:
LCategory: |

SRS: Caoo [ 5|

Arbitrary %7 Coordinates (US Survey Feet]
Arbitrary ¥ Coordinates (US Survey Inches)

Arbitrary %7 Coordinates [International Feet]

Arbitrary %7 Coordinates [Clarke Feet)

Arbitrary %7 Coordinates (International Inches)
Arbitrary ¥ Coordinates [Centimeters)

Arbitrary %7 Coordinates [Kilometers]

Arbitrary %7 Coordinates [Englizh vards]

Arbitrary % Coordinates [Sears Yards)

Arbitrary %7 Coordinates (US Survey Mileg]

Arbitrary %7 Coordinates (International v'ards]

Arbitrary %7 Coordinates [International Miles)

Arbitrary %7 Coordinates [Knotz) LI
dirhitrar % Conrdinates (M aotical biles]

Mote: The selected "Default SRS" will apply to all SHP files specified for
the search path for this UDL.

QK I Cancel | Help |

6 Click OK to close the Data Link Properties dialog box.

Provider for SHP adds the coordinate system information to the data
source.

Creating Data Sources

If you create your first MWF using the default SHP data source, and you want
to create another MWF using SHP data in a different coordinate system or
location from the one specified by the default SHP data source, you must
create a new SHP data source.

You can perform the configuration tasks to modify or create data sources,
which are Microsoft® Universal Data Link (UDL) files, using Autodesk
MapGuide® Server Admin, or you can use a text editor. Using Autodesk
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MapGuide Server Admin provides a graphical user interface for configuring
the data sources, so it is easier to use than a text editor. Using a text editor is
recommended for developers who want to configure data sources program-
matically, for example, to configure a large number of UDLs in batch mode.

Using Autodesk MapGuide Server Admin to
Create Data Sources

This section describes how to create a data source using Autodesk MapGuide
Server Admin.

To create a data source using Autodesk MapGuide Server Admin

1 In Autodesk MapGuide Server Admin, choose Edit » Properties, and click
the Data Sources tab in the Properties dialog box.

The data sources are displayed.

Properties [ %]
General Data Sources | Loggingl Users.-"GroupsI Hesourcesl Access Ke_l,lsl
Data sources:
Mame Available Mew...

S ample_‘world_DE
S ample_\world_SDF
SHP

Hﬂﬂi

Eename... |
Delete |

Data zource search path:

E:\Program FilegAutodesk\M apGuideServerBiD ata Sources

QK Cancel Lpply Help

2 Click New.
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Chapter 2

The New Data Source dialog box is displayed.

Data source name:

[rata source type

& Microzoft Data Link (UDL] for OLE DB
' Autodesk Data Link [ADL) for DWG

[k | Cancel | Help |

Enter the name of the Microsoft Data Link (UDL) for OLE DB data source,
for example, enter SHP2, and click OK.

Autodesk MapGuide Server Admin displays the Data Link Properties dia-
log box.

Click the Provider tab, and select the Autodesk Spatial Data Provider for
SHP from the list of data providers.

The Data Link Properties dialog box is displayed showing the list of data
providers.

B3 Data

k Properties E
Frawider | Eonnectionl Advancedl Al I

Select the data you want to connect to:

| OLE DE Froviderfs)

Autodesk Spatial Data Provider for SDF
Autod | d 5

Microsoft Jet 3.51 OLE DB Provider

Microsaft Jet 4.0 OLE DB Provider

Microzoft OLE DB Provider for Intemet Publishing
Microsoft OLE DB Provider for Microsoft Index Server
Microsoft OLE DB Provider for Microsoft Site Server Search
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for OLAP Services
Microsoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for SOL Server

Microzoft OLE DE Simple Provider

M5 Remate

MSDataShape

Met Library Collator

OLE DB Provider for Microsoft Directory Services

Mext »» |
QK I Cancel | Help |
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5 Click Next, and then click the Connection tab.

6 Enter the SHP search path (for information about entering the search
path, see the rules for specifying the SHP search path on page 14).

The following illustration shows an example search path, D:\Shpfiles\.

B3 Data Link Properties k I

Frovider - Cannection |Advanced| Al I

Specify the following to connect to this data:
1. Enter the SHP Search path:
Search Path: ID:\ShpFiIes

Maote: Multiple paths need to be delimited by the ' character.
Example: C:ASHPs:D:ASHPs

QK | Cancel | Help |

7 Click the Advanced tab, and then specify the coordinate system in which
the SHP files are stored.

8 Click OK to close the Data Link Properties dialog box.
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The Properties dialog box is displayed showing the name of the new data
source in the Data Sources tab.

Properties [ %]
General Data Sources | Loggingl Users.-"GroupsI Hesourcesl Access Ke_l,lsl
Data sources:
Mame | Available | | I
Civag

S ample_‘world_DE
S ample_\world_SDF
SHP

SHPZ2

Eroperties... |
Eename... |
[elete |

Data zource search path:

E:\Program FilegAutodesk\M apGuideServerBiD ata Sources

QK | Cancel | Lpply | Help |

Using a Text Editor to Create Data Sources

To modify the UDL file using a text editor, you must enclose the SHP search
path in quotation marks inside the UDL file as shown in the following
example of a connection string.:

[oledb]

; Everything after this line is an OLE DB initstring
Provider=ASDPSHP.SHPSDP.1;Data Source="";

Extended Properties="";

SHP Search Path="E:\shape files\;E:\SHP\";Default SRS=*XY-MT*

A connection string is a string version of the initialization properties needed
to connect to a data source. For information about the connection string and
using Windows tools to create and modify a data source, refer to the
Microsoft Developer Network documentation.
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Using Provider for SHP

This chapter describes how to author and publish maps
containing SHP data by first saving SHP files to a location
in the SHP search path, and then associating the SHP data
with a layer in Autodesk MapGuide® Author. It describes
how you use Autodesk MapGuide Author to save the map
containing the SHP layer to an MWEF file, and how
Autodesk MapGuide® Server serves the MWF over the

Internet or intranet.

M
[

In this chapter

Authoring maps
Using Zoom Goto categories

Preparing the map for
delivery

Viewing the MWF in
Autodesk MapGuide Viewer
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Authoring Maps

34

Using Autodesk MapGuide Author and Provider for SHP, you follow these
general steps to create maps using native SHP data For more information
about authoring maps, refer to the Autodesk MapGuide Users Guide.

1

w©n b WN

Create the SHP layer using Autodesk MapGuide Author to associate a layer
with a SHP file.

Name features, assign URL links to features, or filter features (optional).
Set the center and size of the SHP map.
Create Zoom Goto categories (optional).

Prepare the map for viewing over the Internet or an intranet by setting its
size and saving it as an MWE.

Creating the SHP Layer

This section describes how to create a SHP layer.

To create a SHP layer

1

2

In Autodesk MapGuide Author, open an existing MWF file, or create a new
one.

In the Map Explorer, right-click Map Layers to display the Map Layer

popup menu, choose New Layer, and then choose either Text, Point, Poly-
line, or Polygon. For example, choose New Layer » Polygon.

The following window shows these menu selections.

4, Autodesk MapGuide Author - [Map1]

&Eile Edit Mavigate Bookmarks Select Yiew ‘Window Help _|ﬁ||1|

I DEFEEFSE|(FOII X O] 2

-® Mapl |
2} Map Layel™

Mew Layer Teut

5 Mew Layer Group... Eoint
=] Reports Add Layer from File... Falyline
ol e
= ‘olygon
""" =l Fomiphe  Eeste Autodesk DWG
Rebuild All Layers Autodesk GIS Design Server Theme

BRaste

~ Expand
Design Yie  Collapse 3
[ |0 feature(s] selected 1:425271296 |
|Cleale a new polygon layer b
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The Map Layer Properties dialog box is displayed after you choose
Map Layers » New Layer » Polygon.

Map Layer Properties - New Layer [ %]

General | Data Sourcesl Styles I Securityl

Layer type: Polygon

Layer name: Mew Layer

Legend label: ¥ Show in Viewer legend

V' Make map features selectable

Map data
’76’ Dynamic " Static

Dirave pricrity: |82.EDDD _I;

QK I Cancel | Help

3 On the General tab, enter the layer name and legend label.

4 Click the Data Sources tab, and check that the Map Server URL contains
the address of your Autodesk MapGuide Server. If the Map Server URL
points to www.mapguide.com, you must change it to the URL for the
MapAgent broker for your Autodesk MapGuide Server.
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The Map Server URL drop-down list shows that your map server URL has
replaced the default.

Map Layer Properties - New Layer [ %]

General Data Sources | Styles I Securityl

Diraw features from:

I SDF [Spatial D ata Provider) data source

Ll

SDP Data Source | MName, URL, Where I

[rata zource:
Feature table:
Key column: Key column type:
e [~
Geometry column:
Map zerver URL:
Ihttp:.-".-"Ioc:alhost.-"MapGuideBa"mapagent.exe j
QK Cancel | Help |

Map Server URL

5 On the SDP Data Source tab, click the browse button for Data Source.

6 Enter an Autodesk MapGuide Author user name and password if you are
prompted for them. See your system administrator if you do not have a
user name and password.

The Select Data Source dialog box is displayed showing the available data
sources.

Select Data Source [ %]

Data sources:

SHP2

Befresh [k Cancel Help
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7 Select a SHP data source.

The Map Layer Properties dialog box is displayed showing the data source

you selected.

General Data Sources | Styles I Securityl

Diraw features from:

I SDF [Spatial D ata Provider) data source

SDP Data Source | MName, URL, Where I

[rata zource:

[sHP

Feature table:

Key column:

Ll

Key column type:

Map Layer Properties - New Layer [ %]

Geometry column:

L L L e

Map zerver URL:

Ihttp: /flocalhost/M apGuideB/mapagent. exe

=

Cancel | Help |

ok |

8 Click the browse button for the Feature Table.
The Select Table dialog box is displayed showing the list of feature tables.

Select Table

Tables:

Cddpoints”

anho
brklinz
madrid
massphtz
mpatch3
multipatch
multipnt
hanway
pline
polygon

Refiesh | ot |

Cancel |

Help |

If the table of SHP data you want is not listed, copy the SHP file and its
associated DBF and SHX files to the directory specified by the SHP search
path setting. Click the Refresh button.
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9 Select the name of the table containing features that you want to display
on this layer.

Note Do not change the values in the Key and Geometry columns.

The Map Layer Properties New Layer dialog box is displayed showing the
values in the Feature Table, Key Column, and Geometry Column sections.

Map Layer Properties - New Layer [ %]

General Data Sources | Styles I Securityl

Diraw features from:

ISDF' [Spatial D ata Provider) data source j

SDP Data Source | MName, URL, Where I

[rata zource:

[sHP J

Feature table:

Inorway

Key column: Key column type:

IFEATUHE_ID J IUnsigned Integer j

Geometry column:
[FEaTURE_GEOM J

Map zerver URL:
Ihttp:.-".-"loc:alhost.-"M aplGuideb/mapagent. exe j

QK | Cancel | Help |

10 Click OK to close the Map Layer Properties dialog box.

If you cannot see the map after creating the SHP layer or if the map is too
small or too large, follow the procedure “Setting the Center and Size of the
Map” on page 43 to change the parameters for displaying the map.

Follow instructions in the next section to assign names to map features.

Naming Features

You use the Name, URL, Where tab on the Data Sources tab of the Map Layer
Properties dialog box to specify the column of the DBF file that contains the
names for map features on the SHP layer. The name of a feature is displayed
as a MapTip when the user pauses the mouse pointer over that feature, and
it is displayed as a feature label at specified zoom levels (unless the label
would overpost another label).

The column values used in the DBF may not be descriptive enough for use as
a MapTip or feature label. For example, the DBF contains a column of parcel
numbers that you want to use as MapTips. You want to preface each parcel

number with the words “parcel number” and a space, to create MapTips that
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are self-explanatory (for example, parcel number 4563). With OLE DB layers,
you can enhance column names by concatenating strings to the column
name (for example, “parcel number: “+ FEATURE_NAME).

For more information about MapTips, choose Help » Contents in Autodesk
MapGuide Author, click the Index tab, and look up “MapTips.” For more
information about feature labels, choose Help » Contents in Autodesk
MapGuide Author, click the Index tab, and look up “labels for features.”

Note Provider for SHP does not support multiline MapTips.

The following procedure assumes that you created the SHP layer as described
in “Creating the SHP Layer” on page 34.
To assign feature names

1 Click the Data Sources tab of the Map Layer Properties dialog box.
2 Click the Name, URL, Where tab.
The Name, URL, Where tab is displayed .

Map Layer Properties - New Layer [ %]

General Data Sources | Styles I Securityl

Diraw features from:

ISDF' [Spatial D ata Provider) data source j
SDP Data Source  Mame, URL, Wwhere |
™ Lirk to secondary table Select Secondany Table... |
Mame source: Mame column:
I Feature table j || J
UBL source: URL columm:
I Feature table j I J
Apply SOL where clause to: S0L where clause:
I Feature table j I

Map zerver URL:
Ihttp:.-".-"loc:alhost.-"M aplGuideb/mapagent. exe j

QK I Cancel | Help |

3 Click the browse button for the Name Column.
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The Select Column dialog box is displayed showing the names of the col-
umns of the DBF associated with the SHP layer, in this example the col-
umns of the norway.dbf file associated with a Norway SHP file.

Select Column [ %]

Lolumns:

ARES
FEATURE_GEOM
FEATURE_ID
FRAWN

KNR
FOMMUNER_
FOMMUNER_I
PERIMETER
#*_COORD
Y_COORD

Befresh | [k | Cancel | Help |

Select the column that contains the names of features whose labels you
want to display.

In this example, you select KNAVN to display the names of Norwegian
cities as MapTips and feature labels.

5 Select and zoom the map.

6 Position the mouse pointer over a feature, and pause.

A MapTip (in this example, Lesja) is displayed.

&Eile Edit Mavigate Bookmarks Select

45, Autodesk MapGuide Author - [Map1 - D:\Program Files\Autodesks .. [I[=] E3

Wiew ‘window Help - | = |1|

| DEPESRROXIX IR OQ[ 1] 2|

@ Mapl
158 Map Layers
] =

- == ‘woarld Cauntries
Feports
¥ Zoom Gotos

- Citiez in Monway
ﬂ FPopup Menu

|Noma_v : Lesja

[1 "Morway' selected

[ 4

To display feature labels

1 Click the Styles tab in the Map Layer Properties dialog box.
2 Select the Label Map Features check box.
3 Click OK to close the Map Layer Properties dialog box.
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For more information about feature labels, choose Help » Contents in
Autodesk MapGuide Author, click the Index tab, and look up “vectors,
Setting Style Properties in Vector Layers.”

Follow the instructions in “Preparing the Map for Delivery” on page 56 to
display the map properly for Autodesk MapGuide Viewer users.

Assigning URL Links to Features

This section describes how to assign URL links to features. You save SHP
layers as MWEF files in Autodesk MapGuide Author and place the MWF files
in a Web directory on Autodesk MapGuide Server. Then, an Autodesk
MapGuide Viewer user can click a feature displayed on a SHP layer to which
you have assigned a URL link and go directly to the Web page.

To assign URL links to features

1 In the DBEF file of the SHP data source to which you want to assign URLs,
create a column containing URLs.

2 Click the Data Sources tab of the Map Layer Properties dialog box.

3 Click the Name, URL, Where tab.

4 Click the browse button for the URL Column, and select the name of the
column that contains the URLs associated with the map features.

Tip The column can contain FTP URLs or JavaScript commands, such as

javascript:alert ("This pump is inactive.").

5 Click OK to close the Map Layer Properties dialog box.

Filtering Features

You can specify a SQL WHERE clause to filter the display of map features on
the map layer. Using the WHERE clause, you refer to a column from the
feature table.

Note Do not include the word “where” in a WHERE clause.

The following procedure assumes that you created the SHP layer as described
on page 34.

To filter map features

1 Click the Data Sources tab of the Map Layer Properties dialog box.
2 Click the Name, URL, Where tab.
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3 Enter in the SQL Where Clause text box a logical expression that is based
on the contents of the DBF file. For this example, enter AREA > 0.3 to fil-
ter out the display of Norwegian cities with an area of 0.3 or smaller.

The SQL Where Clause value is set to AREA > 0.3.

Map Layer Properties - New Layer [ %]

General Data Sources | Styles I Securityl

Diraw features from:

ISDF' [Spatial D ata Provider) data source j
SDP Data Source  Mame, URL, Wwhere |
™ Lirk to secondary table Select Secondany Table... |
Mame source: Mame column:
[Feature table = [ken [
UBL source: URL columm:
I Feature table j I J
Apply SOL where clause to: S0L where clause:
|Feature table =] [ereal 03

Map zerver URL:
Ihttp:.-".-"loc:alhost.-"M aplGuideb/mapagent. exe j

QK I Cancel | Help |

4 Click OK to close the Map Layer Properties dialog box.

The Map Window is displayed showing Norwegian cities with an area
greater than 0.3.

Autodesk MapGuide Author - [Map1 - D:\Program Files\Autodesk\... [H[=] E3

Eile Edit Mavigate Bookmarks Select Yiew ‘Window Help ;Iilll
| DEPESRROXIX IR OQ[ 1] 2|
@ Mapl

158 Map Lapers

- HM =

- == ‘Warld Countries
Feports

= ¥ Zoom Gotos

ﬂ FPopup Menu

[ [1 "Morway' selected
|F|ead_v |1 2018 bytes transferred v
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Setting the Center and Size of the Map

You set the center and size of the map for the following reasons:

m To make it visible in Autodesk MapGuide Author; otherwise, Autodesk
MapGuide Author handles the coordinates relative to the map origin 0, 0
when you create the SHP layer.

m To set the display parameters for delivery of the map to Autodesk
MapGuide Viewer users.

There are two ways to set the center and size of the map. The easiest way is
to zoom to the map features and set the center and size as described in the
next section,”“Select and Zoom Method.” A more precise way of setting the
center and size, as described in “Enter Values Method” on page 45, requires
that you know the XY coordinate, width, and height of the SHP data.

Select and Zoom Method

This procedure assumes that you just finished creating a SHP layer as
described in the “Creating the SHP Layer” on page 34.

To set the center and size of the map by zooming

1 In Autodesk MapGuide Author, turn off all layers except the SHP layer.

The Map Window is displayed showing only the contents on the SHP
layer, in this example the map of Norway.

4, Autodesk MapGuide Author - [Map1]

&Eile Edit Mavigate Bookmarks Select Yiew ‘Window Help ;Iilll
| DEEESB(ROIX I O@C[E]2 |

@ Mapl
158 Map Layers
= Monway
‘wiorld Countries
Reports
- J¥ Zoom Gotos

ﬂ FPopup Menu

[ |0 feature(s] selected
|Ready [ A

2 Choose Select » Map Features.
3 Click All and then click OK.
4 Choose Edit » Zoom Selected.
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The display zooms in on the map of Norway.

4, Autodesk MapGuide Author - [Map1 - D:\Program Files\Autodesk\MapG... =] E3
& File Edit Mavigate Bookmarks Select Wiew ‘Window Help

==l x|

|D@gEsnk x|z oqd|? |

®
=] Map Layers
= Monway
=== World Countries
Reports
¥ Zoom Gotos

|

|l] feature[s] selected

|To cancel ‘zoom in', press Esc keyp.

4

5 Right-click the map to display the Map Window popup menu, and then

choose Properties.

The Map Window Properties dialog box is displayed.

Mame:

ap1

Map Window Properties [ %]

General | Coardinate Systeml Heportsl Zoom Gotol Fopup Menul Securityl

Background color:

Wiew distance function

— Center and size

Latitude: Longitude: & Euslid
* Euclidean

|0.000000 = |o.000000 =
" Great Circle

‘width [DEGREE]: Height [DEGREE]:

[375 = [z =

Take Center and Size from Current Zoom | APl Symbols. .. |

QK I Cancel Help |

6 On the General tab of the Map Window Properties dialog box, click Take
Center And Size From Current Zoom.

Autodesk MapGuide Author calculates and sets the Latitude, Longitude,
Width, and Height values of the map according to the way it is displayed

at the current zoom level.

7 Click OK to close the Map Window Properties dialog box.
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Enter Values Method

You can set the center and size of the map using actual values for the center

and size of the SHP data.

To set the center and size of the map using actual values

1 Turn off all layers except the SHP layer.

2 Right-click in the map to display the Map Window popup menu, and
choose Properties.

The Map Window Properties dialog box is displayed.

General | Coardinate Systeml Heportsl Zoom Gotol Fopup Menul Securityl

Mame: Background color:

ap1

— Center and size Wiew distance function
Latitude: Longitude: # Euclidean
|0.000000 = |o.000000 =
" Great Circle
‘width [DEGREE]: Height [DEGREE]:
[375 = [z =
Take Center and Size from Current Zoom | APl Symbols. .. |

QK I Cancel | Help |

3 On the General tab, enter the center and size of the SHP data. For this
example, set the following values:

Latitude (X-Coordinate): 64.57
Longitude (Y-Coordinate): 17.88
Width: 26.47

Height: 15.61

4 Click OK to close the Map Window Properties dialog box.
The SHP map is displayed, centered and in the size you specified.

Follow instructions in “Preparing the Map for Delivery” on page 56 to
display the map properly for Autodesk MapGuide Viewer users.

Authoring Maps
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Using Zoom Goto Categories

Zoom Goto categories are a set of locations, set up in Autodesk MapGuide
Author, to which the Autodesk MapGuide Viewer user can zoom by name.
For example, you can set up a category for the cities in a Norway SHP file, and
the users can zoom to a city by typing its name.

This section describes how to create and test a Zoom Goto category.

Creating a Zoom Goto Category

You get information to create the Zoom Goto category for a SHP layer from
the DBF file associated with the SHP file.
To create a Zoom Goto category

1 Open the DBF file associated with the SHP layer to which you want to add
a Zoom Goto Category. For example, using Microsoft® Excel, open

norway.dbf.
The columns of data contained in norway.dbf are displayed.
B Ble Edit Yiew Insert Format Ieols Data sindow Help
DeHaaRy|sme - &= &8l l@E 2 e co B zul|=
Al | =| AREA
A | B [ C I D ET F I G [ H [ 3‘
1 JAREA IPERIMETER  KOMMUNEF KOMMUNEF KMR | KMAWN ¥ _COORD ¥_COORD =
[ 2 | 0.343 5653 1 12023 Garmvik 97104578125 7899038.50000
[ 3] 0.812 9.451 2 2 2022 Lebesby 919353.75862 7869723.00000
[ 4 0.275 3315 3 3 2024 Berlevoy 1016750.93750 7901850.00000
[ 5] 0.340 4375 4 4 2028 Botsfjord 105312987500 7891100.00000
[ B | 0.247 5315 5 5 2018 Mos®y 85047415625 7885500.00000
[ 7 0.225 6.033 5] B 2019 Mordkapp 586150.00000 7916550.00000
= 0.938 10,435 7 7 2025 Tana S967800.00000 7842250.00000
[ 9 0.140 2295 g B 2002 vard® 1080240.50000 7878249.50000
10 1.155 8.8 g 9 2020 Porsanaer 864641.05333 7825587.00000 Jﬂ
44 T ¥ norway / (Kl | ol
Realy | I T e |

2 Note the name of the column that has the information you want to zoom
to.

If you want users to zoom to cities in Norway, note the name of the col-
umn of cities, KNAVN.

3 In Autodesk MapGuide Author, choose File » Open, and click the file
containing the SHP layer.

For this example, open an MWF that contains a SHP layer created from a
SHP file called norway.shp.

46 | Chapter 3 Using Provider for SHP



Right-click in the map to display the Map Window popup menu, and
choose Properties.
Click the Zoom Goto tab, and click New.

The Map Window Properties dialog box is displayed showing the default
values for Category, Map Server URL, and SQL Select Statement.

Map Window Properties [ %]

Generall Coordinate Systeml Reports  £oom Goto | Fopup Menul Securityl

Lategory: Category 1 j Hew | Remove |
Map zerver URL: Ihttp:.-".-"loc:alhost.-"M aplGuideb/mapagent. exe j
Data zource: I J & reture: 200 _:I

SOL select statement: |select <Location Mame:, [<Geometry Columns ] or [<Min_Lat, <Min_Londs, ;I
<Max_Lat ', <Max_Lond<] from <Feature Table: where <Location Mame:
like “Zs%%" order by <Location Mame: LI

Access key Confirm access key:

[ [
QK I Cancel | Help |

Change the name of the default category to one that suits the category
you are creating. For this example, name the category Cities in Norway.

Check that the Map Server URL is set to the URL and MapAgent for your
server.

Click the browse button for the Data Source. Enter your Autodesk
MapGuide Author user name and password if you are prompted for them,
and then click the data source containing the target data for the Zoom
Goto category.

Change the default SQL statement to query the database for the locations
you want users to zoom to. For this example, to select any of the Norwe-
gian cities listed in the norway.dbf file, replace the default SQL statement
with the following statement:

select KNAVN, FEATURE_GEOM from norway where KNAVN like '%s%%'
order by KNAVN

For more information, see “Creating SQL Statements for Zoom Goto Cat-
egories” on page 48.
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The following dialog box shows the value of the SQL Select Statement set
to select Norwegian cities.

Map Window Properties [ %]

Generall Coordinate Systeml Reports  £oom Goto | Fopup Menul Securityl

Lategory: j Hew | Remove |
Map zerver URL: Ihttp:.-".-"MDLDKINI.-"mapguideS.-"mapagent.exe j
Data zource: ISHF'2 J & reture: 200 _:I
SOL select statement: |select KMAYN, FEATURE_GEOM from nonway where KMAWN like s34 order ;I
by KNAWN
[
Access key Confirm access key:

[ [
QK I Cancel | Help |

10 Close the DBF file that you opened in step 1, and click OK to close the Map
Window Properties dialog box.

The Zoom Goto categories are set up and you can zoom to specified locations
by name. For information about using the Zoom Goto categories, see
“Testing a Zoom Goto Category” on page 54.

Creating SQL Statements for Zoom Goto
Categories

SQL statements describe how to query the database for the locations you
want users to zoom to. Creating the SQL statement is an essential step in
creating a Zoom Goto category. For example, step 9 of “Creating a Zoom
Goto Category” on page 47 tells you to change the default SQL statement to
query the database for the locations you want users to zoom to. You create
the SQL statement for the Zoom Goto category by modifying the default SQL
statement that is displayed on the Zoom Goto tab of the Map Window Prop-
erties dialog box.

To create a SQL statement for a Zoom Goto category
1 Open the DBF file associated with the SHP layer to which you want to add
a Zoom Goto Category.

2 Using the Zoom Goto tab of the Map Properties dialog box, you click New
to create a new Zoom Goto category.
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The following default SQL statement is displayed; use the default state-
ment as a model:

select <Location Name>, (<Geometry Column>) or (<Min_Lat/Y>,
<Min_Lon/X>, <Max_Lat/Y>, <Max_Lon/X>) from <Feature Table> where
<Location Name> like '%s%%' order by <Location Name>

3 Remove the following characters from the default SQL statement:
m The parentheses
m The OR operator
m The angle brackets < >, except the last set
m The characters Min_Lat/Y, Min_Lon/X, Max_Lat/Y, Max_Lon/X

The resulting model SQL statement is:

select Location Name, Geometry Column from Feature Table where
Location Name like '%s%%' order by <Location Name>

4 Replace variables and angle brackets as described in the following table:

Instructions for Replacing Default SQL Statement Variables

Variable Instructions

<Location Name> Enter the name of the column in the DBF file
that contains the name of the feature you want
to zoom. For example, in the Norway DBF
shown in the previous procedure, the cities are
listed in the column KNAVN, so this is the
<Location Name>. Insert a comma after the
location name. Use uppercase or lowercase
characters because the location name is case
insensitive.

<Geometry Column> Enter FEATURE_GEOM in your SQL statement to
select the column from the DBF. Delete the vari-
ables prefaced by Min_ and Max_.

Using Zoom Goto Categories | 49



Instructions for Replacing Default SQL Statement Variables (continued)

Variable Instructions

<Min_Lat/Y> Not used by Provider for SHP or other Spatial

<Min_Lon/X> Data Providers. You use this variable with prod-

<Max_Lat/Y> ucts such as Autodesk GIS Design Server Access

<Max_Lon/X> Extension to zoom to a point specified by mini-
mum and maximum values in a database
column.

<Feature Table> Enter the name of the SHP file without the SHP

file extension. For more information about the
feature table variable, see “Understanding the
Feature Table Variable” in the next section.

For example, to select Norwegian cities listed in the norway.dbf file, replace
the default SQL statement with the following statement:

select KNAVN, FEATURE_GEOM from norway where KNAVN like ‘%s%%’ order
by KNAVN

Understanding the Feature Table Variable

You can create a query using a fully qualified path for the feature table name

(SHP file name). If the feature table name includes path information that is

different from the SHP search path, the SHP search path is ignored, and the

included path is used in the query. If the query does not contain a fully qual-
ified path, the first file that matches the given feature table name in the SHP
search path is used as the feature table.

Supported SQL Features

The following list shows the SQL features supported by Provider for SHP:

m min(), max(), and count() functions

m DISTINCT

m A simple WHERE clause that meets the following specifications:
m Supports multiple predicates

m Supports the following evaluators: =, <, >, <>, >=, <=, LIKE, NOT LIKE,
IS NULL, IS NOT NULL, IN, NOT IN

m ORDER BY is either ASC or DESC
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Using SQL Keywords as Column Names

SHP DBF files may have column names that are SQL keywords. To use such

column names in SQL statements, you must enclose them in quotation

marks. For example, if a column in the DBF is named DESC, use “DESC” in

your SQL statement.

The following table lists Oracle and ANSI SQL keywords:

SQL Keywords

ACTION

ALL

ANY

AT

BIT

CASCADE

CHAR

CLOSE

COLLATION

CONSTRAINT

CROSS

CURRENT_TIME

CURSOR

DEC

DEFAULT

ADA

ALTER

AS

AUTHORIZATION

BOTH

CASCADED

CHARACTER

COBOL

COLUMN

CONTINUE

CURRENT

CURRENT_TIMESTAMP

DATE

DECIMAL

DEFERRED

Using Zoom Goto Categories

ADD

AND

ASC

BETWEEN

BY

CAST

CHECK

COLLATE

COMMIT

CREATE

CURRENT_DATE

CURRENT_USER

DAY

DECLARE

DELETE
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SQL Keywords (continued)

DESC DISTINCT DOMAIN
DOUBLE DROP ESCAPE
EXISTS EXTRACT FETCH
FLOAT FOR FOREIGN
FORTRAN FOUND FROM
FULL GLOBAL GO

GOTO GRANT GROUP
HAVING HOUR IN

INT INDEX INDICATOR
INNER INITIALLY INSERT
INT INTEGER INTERVAL
INTO IS JOIN

KEY LANGUAGE LEADING
LEFT LIKE LOCAL
MATCH MINUTE MODIFY
MODULE MONTH NATIONAL
NATURAL NCHAR NO

NOT NULL NUMERIC
OF ON OPEN
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SQL Keywords (continued)

OPTION

OUTER

PASCAL

PRECISION

PROCEDURE

REFERENCES

REVOKE

SCHEMA

SESSION_USER

SOME

TABLE

TIMEZONE_HOUR

TO

TRANSLATION

UPDATE

VALUES

VIEW

WITH

ZONE

OR

OVERLAPS

PLI

PRIMARY

PUBLIC

RENAME

RIGHT

SECOND

SET

SQLCODE

TEMPORARY

TIMEZONE_MINUTE

TRAILING

UNION

USER

VARCHAR

WHENEVER

WORK
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ORDER

PARTIAL

POSITION

PRIVILEGES

REAL

RESTRICT

ROLLBACK

SELECT

SMALLINT

SYSTEM_USER

TIME

TIMESTAMP

TRIM

UNIQUE

USING

VARYING

WHERE

YEAR
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Using SQL Comparisons with Evaluators

Provider for SHP compares evaluators based on the data type of the source
DBF column.

In the following example, if the PARCEL column data type is numeric,
Provider for SHP makes a numerical comparison:

select NAME, PARCEL from MyTable where PARCEL < 20

Unsupported Features

Provider for SHP does not support all SQL features. The following list
includes some of the features that are not supported:

m Joins
m Aliases
m Multiple tables

For more information about SQL features, keywords, and functions, refer to
the Oracle SQL documentation.

Testing a Zoom Goto Category

Using Autodesk MapGuide Viewer or Autodesk MapGuide Author, you can
zoom to the Zoom Goto locations you set up in Autodesk MapGuide Author.
It is more convenient to test the Zoom Goto category from within the
authoring environment.

To test a Zoom Goto category

1 Assuming you just finished the procedure “Creating a Zoom Goto Cate-
gory” on page 46, choose Edit » Zoom Goto from the Autodesk
MapGuide Author popup menu.

The Zoom Goto dialog box is displayed.
2 Select the Zoom Goto category that you want to test.
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3 Inthe Zoom Goto dialog box, enter a location (in uppercase and lowercase

characters) from the column that you specified as the <Location Name>
in the Zoom Goto SQL statement. For example, enter the value Gamvik

from the KNAVN column of the Norway DBFE.
The Location value set to Gamvik is displayed.

Lacation |
LCategory : IEities in Monway j
Location : IGamvik
Zoom to width : W [mi]
Select a category then enter a location to goto...
QK I Cancel | Help |

4 Click OK to close the Zoom Goto dialog box.
The Map Window is displayed showing the city Gamvik.

@
[

45, Autodesk MapGuide Author - [Map1 - D:\Program Files\Autodesks .. [I[=] E3

&Eile Edit Mavigate Bookmarks Select Yiew ‘Window Help ;Iilll
| DEEESE RO OR[]? |

Map Layers

-] = Monwap

- == ‘Warld Countries
Reports

¥ Zoom Gotos

C@ Citiez in Monway
ﬂ FPopup Menu

orway - Gamvik

[1 "Morway' selected

4
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Preparing the Map for Delivery

You can zoom the map to the size you want to deliver to users, and clip it.

To prepare the map for delivery

1 Zoom in or out to display the detail that you want users to see.

2 Right-click in the map to display the Map Window popup menu, and
choose Properties.

The Map Window Properties dialog box is displayed.

3 Click Take Center And Size From Current Zoom to clip the map.
4 Click OK in the Map Window Properties dialog box.
5 Choose File » Save to save the data as an MWE.
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Viewing the MWF in Autodesk MapGuide

Viewer

Users can view the SHP information in the MWF over the Internet or an

intranet.

To test and view the SHP file using Autodesk MapGuide Viewer

1 Save the layer in Autodesk MapGuide Author, and put the MWF in a Web
directory on the Autodesk MapGuide Server.

2 Open a browser.

3 Enter the URL

to the MWFE. For example, if your Web server URL is

www.ServerName.com and your Web directory is called MapGuide, enter
the following URL:

http://www.ServerName.com/MapGuide/norway.mwf{

The SHP map is displayed in Autodesk MapGuide Viewer.

/ http:/ /molokini/S ample_World/shp. mwf - Microzoft Internet Explorer [H[=] [E3

j File Edit “iew Favortes Tools »j & - > jAgdress jLinks >
Back
BRI NXK| @2 autodesk’

= Mew Layer

[ == ‘warld Countries

[ |

1: 55.658.587 2,745 x 1.217 [mi)

|@ Done

’_’_ 2+ Local intranet A

Viewing the MWF in Autodesk MapGuide Viewer
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Geometry Mapping and
Troubleshooting

This chapter describes problems that you might encoun-
ter with Autodesk MapGuide® Provider for SHP and how
to solve them. It also covers the geometry mapping

between the OLE DB components and how Provider for

SHP determines feature table availability.

In this chapter

Troubleshooting
Known issues
Error handling

Geometry mapping
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Troubleshooting

This section describes solutions to common problems that occur when using
Provider for SHP.

Autodesk MapGuide Author Denies
Authorization
Problem You receive the Author Authentication Failed error message, even

though you have entered the correct user name and password, and you are a
member of the Authors group.

Autodesk MapGuide Author [ %]

& Authoring authentication failed. Check the following:

1. Y'ou are uging a valid user name and password.

2. You are a member of the “Authors" group.

Solution Make sure that you have entered the correct Map Server URL in the
Map Layer Properties dialog box.

Visibility of the Map In Autodesk MapGuide
Author

Problem You cannot see the map on the SHP layer in Autodesk MapGuide®
Author.

Solution

1 In the Map Explorer, turn off layers other than the SHP layer.

2 Choose Select » Map Features.

3 Click All

4 Choose Edit » Zoom Selected.
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Visibility of the Map in Autodesk MapGuide
Viewer

Problem The user cannot see the map in Autodesk MapGuide® Viewer.

Solution The map is either outside the display range of the map or is too
small. Clip the map, as described in “Preparing the Map for Delivery” on
page 56, and ask the user to retry.

Accessibility of SHP Files in Autodesk MapGuide
Server Admin
Problem You cannot access the SHP files using Autodesk MapGuide® Server

Admin.

Solution Check that the SHP files are in the SHP search path. If the data
source does not exist, create the data source as described in “Creating Data
Sources” on page 28.

Accessibility of SHP Files in Autodesk MapGuide
Author

Problem You copied the SHP file to the directory specified by the SHP search
path setting, but it does not appear in the list of available feature tables when

you browse for it using the SDP Data Sources tab in the Map Layer Properties
dialog box.

Solution Try one or both of the following:

m Click Refresh in the Select Table dialog box.
m Check that the correct server URL is displayed under Map Server URL in
the Map Layer Properties dialog box.

Updating or Repairing the Installation

Problem Using the Add/Remove Programs control panel to update or repair
the installation does not update or repair the installation.

Solution

1 Click the setup.exe file on the Provider for SHP CD.
2 Click Next.

3 Follow the on-screen instructions to update or repair Provider for SHP.
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Incompatible Coordinate System

Problem You get the following error message: “The coordinate system associ-
ated with the selected geometry column is not compatible with the map. Use
the Map Window Properties dialog box to specify a compatible coordinate
system.”

Solution The error message is displayed only when the coordinate system of
the MWF is Arbitrary X-Y and the coordinate system information for the data
source is set as a projected coordinate system, or vice versa. For example, the
error message is displayed if the MWF is Arbitrary X-Y and the coordinate
system of the data source is MT83 (NAD83 Montana State Plane Zone,
Meter).

1 Verify that your data source is set up correctly. See”Creating Data Sources”
on page 28.

2 Use the Map Windows Properties dialog box to specify a compatible coor-
dinate system. See “Matching the SHP and MWF Coordinate Systems” on
page 22.

Known Issues

This section describes product problems or characteristics that exist in this
release.

Coordinate System Mismatch

Problem SHP files have been authored in coordinate systems for which there
is no Autodesk MapGuide match.

Solution Using the ArcView® GIS Projection Utility, assign a coordinate
system, for which there is an Autodesk MapGuide match, to the SHP file.

Keywords in SQL Statements

Problem Some SHP files may have been authored with column names, such
as DESC or ADD, that are SQL keywords. Creating SQL statements for Zoom
Goto categories that use these column names causes a SQL error.

Solution Enclose column names that are SQL keywords in quotation marks.
You can then use them in SQL statements.
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Height and Angle of Text for MapTips and Labels

Problem When creating a text layer from a SHP data source, Autodesk
MapGuide Author cannot access the text height and angle because this infor-
mation is in the DBF file.

Solution 1 Set the height and angle of the text in Autodesk MapGuide
Author. This applies the specified height and angle to all text on the layer.

Solution 2 Using SDF Loader, export a comma-separated value (CSV) table
from the SHP source data, using the /COORDSYS: and /TABLE:STYLE:XY:
switches. Use the CSV table to create an OLE DB data source for the Text layer.
This solution applies the height and angle to each specified text feature.

Locked DBF

Problem The DBF cannot be accessed, and it is open.

Solution Close the DBF when you are finished using it and before continuing
to use Provider for SHP.

Access to SHP and OLE DB Data Sources

Problem Spatial data from SHP and OLE DB data sources cannot be accessed
concurrently, which means that you cannot use an OLE DB table as a
secondary table when you access geometry. For example, when you use an
OLE DB data source to access a DBF file, OLE DB attempts to put an exclusive
lock on the file. If Provider for SHP is using the file, OLE DB fails. This is due
to a problem with MDAC.

Solution None for this release.
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getDataFile Method Returns an Empty String

Problem Using Autodesk MapGuide Viewer API with the Java™ Edition
Viewer, when you call the getDataFile method, it returns an empty string
instead of the file name for the SHP layer.

Solution None for this release.

Displaying Multipoint Features

Problem Autodesk MapGuide displays only the first point of a multipoint
SHP feature.

Solution None for this release.

Error Handling

Provider for SHP reports errors in the Event Viewer. Error messages include
an error code, an error level indicator, and a text string describing the error
and the line number, file name, and module name where the error occurred.

Geometry Mapping
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Understanding the mapping of the geometry types identified within SHP
files to the types exported from Provider for SHP is important for using the
products effectively. This section describes how ESRI SHP files map to
OpenGIS WKB Well-Known Binary (WKB) geometry types and how the WKB
types map to Autodesk MapGuide features. It also describes the OpenGIS
geometry types that can be displayed on each Autodesk MapGuide map layer.
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SHP to OpenGIS WKB Geometry

The SHP files use ESRI® geometries, which currently support fourteen
geometric primitives. The following table describes the mapping of SHP
geometry to the OpenGIS WKB geometry type:.

SHP Geometry

OpenGIS WKB Geometry Type

NULL SHAPE N/A

POINT Point

POLYLINE LineString or MultiLineString
POLYGON Polygon or MultiPolygon
MULTIPOINT MultiPoint

POINTZ Point

POLYLINEZ LineString or MultiLineString
POLYGONZ Polygon or MultiPolygon
MULTIPOINTZ MultiPoint

POINTM Point

POLYLINEM LineString or MultiLineString
POLYGONM Polygon or MultiPolygon
MULTIPOINTM MultiPoint

MULTIPATCH MultiPolygon

Geometry Mapping
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OpenGIS WKB Geometry to Autodesk

MapGuide Features

Autodesk MapGuide Server maps OpenGIS Well-Known Binary (WKB) geom-
etry representations to Autodesk MapGuide feature geometry in the context
of the map layer on which the features are displayed. The following table
describes the mapping of OpenGIS WKB geometry by Autodesk MapGuide

layer type:.

Layer Type OpenGIS WKB Geometry

Autodesk MapGuide Feature Geometry

Text Point

Text feature

GeometryCollection

First point element mapped to text fea-
ture, all other elements ignored

Multipoint First point element mapped to point fea-
ture, all other elements ignored
Point Point Point feature

GeometryCollection

First point element mapped to point fea-
ture, all other elements ignored

Multipoint First point element mapped to point fea-
ture, all other elements ignored
Polyline Linestring Polyline feature
MultiLinestring Polypolyline feature
GeometryCollection First linestring or multiLinestring element
mapped to polyline or polypolyline fea-
ture, all other elements ignored
Polygon Polygon Polygon feature if there is only a single
ring, all others become polypolygon fea-
tures
MultiPolygon Polypolygon feature

GeometryCollection

First polygon or multiPolygon element
mapped to polygon or polypolygon fea-
ture, all other elements ignored
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Autodesk MapGuide Layer to OpenGIS WKB

Geometry

The table in this section describes the OpenGIS geometry types that can be
displayed on each Autodesk MapGuide map layer. In Autodesk MapGuide
Author this information is used to validate which geometry columns from
feature tables can be used as sources for each of the map layer types.

Layer OpenGIS WKB Geometry
Text Text

Point Point, Polypoint

Polyline Polyline, Polypolyline

Polygon Polygon, Polypolygon
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Matching SHP and MWF
Coordinate Systems

This appendix consists of a table that describes how ESRI® In this appendix

coordinate systems used in SHP files, and stored in PRJ u Usbi;lg the coordinate system
table

files, map to the equivalent coordinate system used in B Matching coordinate
systems

Autodesk MapGuide® MWF files.
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Using the Coordinate System Table

The default data source that you create when you install SHP Extension
includes the location of the SHP files that you entered during installation,
but no coordinate system information. You must specify the MWF coordi-
nate system that corresponds to the coordinate system of the SHP files before
using the default SHP data source and as you create additional data sources.
For more information, see “Specifying the Coordinate System” on page 26.

Matching Coordinate Systems
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The following table matches coordinate systems of SHP maps to the corre-
sponding MWF coordinate systems based on information from the following
sources:

Australia

Indonesia

New Zealand

State Plane NAD 1927

State Plane NAD 1983

State Plane NAD 1983 (Feet)
UTM WGS 1984

World

If you do not find a corresponding MWF coordinate system, use the
ArcView® GIS Projection Utility to convert the SHP data to a coordinate
system for which there is a corresponding MWF coordinate system.
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Australia

Coordinate Systems for Australia

SHP Coordinate System MWEF Coordinate System CS Code

AGD 1966 AMG Zone 48 None None

AGD 1984 AMG Zone 48 None None

GDA 1994 MGA Zone 48 Map Grid of Australia Zone 48, MGA-48
using GDA94 Datum

AGD 1966 AMG Zone 49 Australian Map Grid Zone 49, AMG66-49
using AGD66 Datum

WGS 1984 UTM Zone 49S Australian Map Grid Zone 49, AMG-49
using AGD84 Datum

GDA 1994 MGA Zone 49 Map Grid of Australia Zone 49, MGA-49
using GDA94 Datum

AGD 1984 AMG Zone 49 Australian Map Grid Zone 49, AMG-49
using AGD84 Datum

AGD 1966 AMG Zone 50 Australian Map Grid Zone 50, AMG66-50
using AGD66 Datum

GDA 1994 MGA Zone 50 Map Grid of Australia Zone 50, MGA-50
using GDA94 Datum

AGD 1984 AMG Zone 50 Australian Map Grid Zone 50, AMG-50
using AGD84 Datum

WGS 1984 UTM Zone 50S Australian Map Grid Zone 50, AMG-50
using AGD84 Datum

AGD 1966 AMG Zone 51 Australian Map Grid Zone 51, AMG66-51
using AGD66 Datum

GDA 1994 MGA Zone 51 Map Grid of Australia Zone 51, MGA-51

using GDA94 Datum

Matching Coordinate Systems
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Coordinate Systems for Australia (continued)

SHP Coordinate System MWEF Coordinate System CS Code

AGD 1984 AMG Zone 51 Australian Map Grid Zone 51, AMG-51
using AGD84 Datum

WGS 1984 UTM Zone 515 Australian Map Grid Zone 51, AMG-51
using AGD84 Datum

AGD 1966 AMG Zone 52 Australian Map Grid Zone 52, AMG66-52
using AGD66 Datum

AGD 1984 AMG Zone 52 Australian Map Grid Zone 52, AMG-52
using AGD84 Datum

GDA 1994 MGA Zone 52 Map Grid of Australia Zone 52, MGA-52
using GDA94 Datum

WGS 1984 UTM Zone 525 Australian Map Grid Zone 52, AMG-52
using AGD84 Datum

AGD 1966 AMG Zone 53 Australian Map Grid Zone 53, AMG66-53
using AGD66 Datum

WGS 1984 UTM Zone 53S Australian Map Grid Zone 53, AMG-53
using AGD84 Datum

AGD 1984 AMG Zone 53 Australian Map Grid Zone 53, AMG-53
using AGD84 Datum

GDA 1994 MGA Zone 53 Map Grid of Australia Zone 53, MGA-53
using GDA94 Datum

AGD 1966 AMG Zone 54 Australian Map Grid Zone 54, AMG66-54
using AGD66 Datum

WGS 1984 UTM Zone 545 Australian Map Grid Zone 54, AMG-54
using AGD84 Datum

AGD 1984 AMG Zone 54 Australian Map Grid Zone 54, AMG-54
using AGD84 Datum

GDA 1994 MGA Zone 54 Map Grid of Australia Zone 54, MGA-54

using GDA94 Datum
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Coordinate Systems for Australia (continued)

SHP Coordinate System MWEF Coordinate System CS Code

AGD 1966 AMG Zone 55 Australian Map Grid Zone 55, AMG66-55
using AGD66 Datum

AGD 1984 AMG Zone 55 Australian Map Grid Zone 55, AMG-55
using AGD84 Datum

GDA 1994 MGA Zone 55 Map Grid of Australia Zone 55, MGA-55
using GDA94 Datum

WGS 1984 UTM Zone 555 Australian Map Grid Zone 55, AMG-55
using AGD84 Datum

AGD 1966 AMG Zone 56 Australian Map Grid Zone 56, AMG66-56
using AGD66 Datum

WGS 1984 UTM Zone 56S Australian Map Grid Zone 56, AMG-56
using AGD84 Datum

AGD 1984 AMG Zone 56 Australian Map Grid Zone 56, AMG-56
using AGD84 Datum

GDA 1994 MGA Zone 56 Map Grid of Australia Zone 56, MGA-56
using GDA94 Datum

AGD 1966 AMG Zone 57 Australian Map Grid Zone 57, AMG66-57
using AGD66 Datum

GDA 1994 MGA Zone 57 Map Grid of Australia Zone 57, MGA-57
using GDA94 Datum

AGD 1984 AMG Zone 57 Australian Map Grid Zone 57, AMG-57
using AGD84 Datum

WGS 1984 UTM Zone 575 Australian Map Grid Zone 57, AMG-57

using AGD84 Datum

Matching Coordinate Systems
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Coordinate Systems for Australia (continued)

SHP Coordinate System MWEF Coordinate System CS Code

GDA 1994 MGA Zone 58 Map Grid of Australia Zone 58, MGA-58
using GDA94 Datum

AGD 1966 AMG Zone 58 None None
AGD 1984 AMG Zone 58 None None
Indonesia

Coordinate Systems for Indonesia

SHP Coordinate System MWEF Coordinate System CS Code

GDA 1994 MGA Zone 48 Indonesia, Java West of 108 IN-JAVAW
degrees East

New Zealand

Coordinate Systems for New Zealand

SHP Coordinate System MWEF Coordinate System CS Code
New Zealand Map Grid New Zealand National Map NZ-MG
Grid, Meter

New Zealand Geodetic Datum New Zealand GD-1949 datum, LL-GD1949
1949 Lat-Long, Degrees -180 to +180
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USA, Administration

Coordinate Systems for USA, Administration

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane StatePlane None None
Guam FIPS 5400
NAD 1927 StatePlane Puerto NAD27 Puerto Rico and Virgin PR-1
Rico FIPS 5201 Islands, Zone 1, US Foot
NAD 1983 StatePlane Guam None None
FIPS 5400
NAD 1983 StatePlane Guam None None
FIPS 5400 (Feet)
NAD 1983 StatePlane Puerto NAD83 Puerto Rico and Virgin PR83
Rico Virgin Islands FIPS 5200 Islands, Meter
NAD 1927 StatePlane Virgin NAD27 Puerto Rico, St Croix Vir-  PR-2
Islands St. Croix FIPS 5202 gin Island, Zone 2, US Foot

USA, Alabama

Coordinate Systems for Alabama
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Alabama State Planes, AL-E
Alabama East FIPS 0101 East Zone, US Foot
NAD 1927 StatePlane NAD27 Alabama State Planes, AL-W
Alabama West FIPS 0102 West Zone, US Foot
NAD 1983 StatePlane NAD83 Alabama State Planes, AL83-E
Alabama East FIPS 0101 East Zone, Meter
NAD 1983 StatePlane Alabama NAD83 Alabama State Planes, AL83-EF

East FIPS 0101 (Feet)

East Zone, US Foot
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Coordinate Systems for Alabama (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane NAD83 Alabama State Planes, AL83-W
Alabama West FIPS 0102 West Zone, Meter

NAD 1983 StatePlane NAD83 Alabama State Planes, AL83-WF
Alabama West FIPS 0102 (Feet) West Zone, US Foot

NAD 1983 StatePlane Alaska 10 NAD83 Alaska State Planes, AK83-10
FIPS 5010 Zone 10, Meter

NAD 1983 StatePlane Alaska 10 NAD83 Alaska State Planes, AK83-10F
FIPS 5010 (Feet) Zone 10, US Foot

NAD 1983 StatePlane Alaska 2 NAD83 Alaska State Planes, AK83-2
FIPS 5002 Zone 2, Meter

NAD 1983 StatePlane Alaska 2 NAD83 Alaska State Planes, AK83-2F
FIPS 5002 (Feet) Zone 2, US Foot

NAD 1983 StatePlane Alaska 3 NAD83 Alaska State Planes, AK83-3
FIPS 5003 Zone 3, Meter

NAD 1983 StatePlane Alaska 3 NAD83 Alaska State Planes, AK83-3F
FIPS 5003 (Feet) Zone 3, US Foot

NAD 1983 StatePlane Alaska 4 NAD83 Alaska State Planes, AK83-4
FIPS 5004 Zone 4, Meter

NAD 1983 StatePlane Alaska 4 NAD83 Alaska State Planes, AK83-4F
FIPS 5004 (Feet) Zone 4, US Foot

NAD 1983 StatePlane Alaska 5 NAD83 Alaska State Planes, AK83-5
FIPS 5005 Zone 5, Meter

NAD 1983 StatePlane Alaska 5 NAD83 Alaska State Planes, AK83-5F
FIPS 5005 (Feet) Zone 5, US Foot

NAD 1983 StatePlane Alaska 6 NAD83 Alaska State Planes, AK83-6
FIPS 5006 Zone 6, Meter

NAD 1983 StatePlane Alaska 6 NAD83 Alaska State Planes, AK83-6F

FIPS 5006 (Feet)

Zone 6, US Foot
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Coordinate Systems for Alabama (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Alaska 7 NAD83 Alaska State Planes, AK83-7
FIPS 5007 Zone 7, Meter
NAD 1983 StatePlane Alaska 7 NAD83 Alaska State Planes, AK83-7F
FIPS 5007 (Feet) Zone 7, US Foot
NAD 1983 StatePlane Alaska 8 NAD83 Alaska State Planes, AK83-8
FIPS 5008 Zone 8, Meter
NAD 1983 StatePlane Alaska 8 NAD83 Alaska State Planes, AK83-8F
FIPS 5008 (Feet) Zone 8, US Foot

USA, Alaska

Coordinate Systems for USA, Alaska
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Alaska 10 NAD27 Alaska State Planes, AK-10
FIPS 5010 Zone 10, US Foot
NAD 1927 StatePlane Alaska 2 NAD27 Alaska State Planes, AK-2
FIPS 5002 Zone 2, US Foot
NAD 1927 StatePlane Alaska 3 NAD27 Alaska State Planes, AK-3
FIPS 5003 Zone 3, US Foot
NAD 1927 StatePlane Alaska 4 NAD27 Alaska State Planes, AK-4
FIPS 5004 Zone 4, US Foot
NAD 1927 StatePlane Alaska 5 NAD27 Alaska State Planes, AK-5
FIPS 5005 Zone 5, US Foot
NAD 1927 StatePlane Alaska 6 NAD27 Alaska State Planes, AK-6
FIPS 5006 Zone 6, US Foot
NAD 1927 StatePlane Alaska 7 NAD27 Alaska State Planes, AK-7
FIPS 5007 Zone 7, US Foot
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Coordinate Systems for USA, Alaska (continued)

East FIPS 0201

East Zone, Meter

Appendix A Matching SHP and MWF Coordinate Systems

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Alaska 8 NAD27 Alaska State Planes, AK-8
FIPS 5008 Zone 8, US Foot
NAD 1927 StatePlane Alaska 9 NAD27 Alaska State Planes, AK-9
FIPS 5009 Zone 9, US Foot
NAD 1983 StatePlane Alaska 9 NAD83 Alaska State Planes, AK83-9
FIPS 5009 Zone 9, Meter
NAD 1983 StatePlane Alaska 9 NAD83 Alaska State Planes, AK83-9F
FIPS 5009 (Feet) Zone 9, US Foot

USA, Arizona

Coordinate Systems for USA, Arizona
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Arizona NAD27 Arizona State Planes, AZ-C
Central FIPS 0202 Central Zone, US Foot
NAD 1927 StatePlane Arizona NAD27 Arizona State Planes, AZ-E
East FIPS 0201 East Zone, US Foot
NAD 1927 StatePlane Arizona NAD27 Arizona State Planes, AZ-W
West FIPS 0203 West Zone, US Foot
NAD 1983 StatePlane Arizona NAD83 Arizona State Planes, AZ83-C
Central FIPS 0202 Central Zone, Meter
NAD 1983 StatePlane Arizona NAD83 Arizona State Planes, AZ83-CF
Central FIPS 0202 (Feet) Central Zone, US Foot
NAD 1983 StatePlane Arizona NAD83 Arizona State Planes, AZ83-E



Coordinate Systems for USA, Arizona (continued)

South FIPS 0302 (Feet)

South Zone, US Foot

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Arizona NAD83 Arizona State Planes, AZ83-EF
East FIPS 0201 (Feet) East Zone, US Foot
NAD 1983 StatePlane Arizona NAD83 Arizona State Planes, AZ83-W
West FIPS 0203 West Zone, Meter
NAD 1983 StatePlane Arizona NAD83 Arizona State Planes, AZ83-WF
West FIPS 0203 (Feet) West Zone, US Foot

USA, Arkansas

Coordinate Systems for USA, Arkansas
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Arkansas NAD27 Arkansas State Planes, AR-N
North FIPS 0301 North Zone, US Foot
NAD 1927 StatePlane Arkansas NAD27 Arkansas State Planes, AR-S
South FIPS 0302 South Zone, US Foot
NAD 1983 StatePlane Arkansas NAD83 Arkansas State Planes, AR83-N
North FIPS 0301 North Zone, Meter
NAD 1983 StatePlane Arkansas NAD83 Arkansas State Planes, AR83-NF
North FIPS 0301 (Feet) North Zone, US Foot
NAD 1983 StatePlane Arkansas NAD83 Arkansas State Planes, AR83-S
South FIPS 0302 South Zone, Meter
NAD 1983 StatePlane Arkansas NAD83 Arkansas State Planes, AR83-SF
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USA, California

Coordinate Systems for USA, California

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD?27 California State Planes, CA-l
California | FIPS 0401 Zone |, US Foot

NAD 1927 StatePlane NAD27 California State Planes, CA-Il
California Il FIPS 0402 Zone ll, US Foot

NAD 1927 StatePlane NAD?27 California State Planes, CA-Ill
California Ill FIPS 0403 Zone lll, US Foot

NAD 1927 StatePlane NAD27 California State Planes, CA-IV
California IV FIPS 0404 Zone 1V, US Foot

NAD 1927 StatePlane NAD27 California State Planes, CA-V
California V FIPS 0405 Zone V, US Foot

NAD 1927 StatePlane NAD27 California State Planes, CA-VI
California VI FIPS 0406 Zone VI, US Foot

NAD 1927 StatePlane NAD27 California State Planes, CA-VII
California VII FIPS 0407 Zone VII, US Foot

NAD 1983 StatePlane NAD83 California State Planes, CA83-I
California | FIPS 0401 Zone |, Meter

NAD 1983 StatePlane California | NAD83 California State Planes, CA83-IF
FIPS 0401 (Feet) Zone |, US Foot

NAD 1983 StatePlane NAD83 California State Planes, CA83-Il
California Il FIPS 0402 Zone ll, Meter

NAD 1983 StatePlane California NAD83 California State Planes, CA83-IIF
Il FIPS 0402 (Feet) Zone Il, US Foot

NAD 1983 StatePlane NAD83 California State Planes, CA83-lll
California Ill FIPS 0403 Zone lll, Meter

NAD 1983 StatePlane California NAD83 California State Planes, CAB83IIIF

Il FIPS 0403 (Feet)

Zone lll, US Foot
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Coordinate Systems for USA, California (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane NAD83 California State Planes, CA83-IV
California IV FIPS 0404 Zone IV, Meter
NAD 1983 StatePlane California NAD83 California State Planes, CA83-IVF
IV FIPS 0404 (Feet) Zone IV, US Foot
NAD 1983 StatePlane NAD83 California State Planes, CA83-V
California V FIPS 0405 Zone V, Meter
NAD 1983 StatePlane California NAD83 California State Planes, CA83-VF
V FIPS 0405 (Feet) Zone V, US Foot
NAD 1983 StatePlane NAD83 California State Planes, CA83-VI
California VI FIPS 0406 Zone VI, Meter
NAD 1983 StatePlane California NAD83 California State Planes, CA83-VIF
VI FIPS 0406 (Feet) Zone VI, US Foot

USA, Colorado

Coordinate Systems for USA, Colorado
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Colorado State Planes, CO-C
Colorado Central FIPS 0502 Central Zone, US Foot
NAD 1927 StatePlane NAD27 Colorado State Planes, CO-N
Colorado North FIPS 0501 North Zone, US Foot
NAD 1927 StatePlane NAD27 Colorado State Planes, CO-S
Colorado South FIPS 0503 South Zone, US Foot
NAD 1983 StatePlane Colorado NAD83 Colorado State Planes, C083-C
Central FIPS 0502 Central Zone, Meter
NAD 1983 StatePlane NAD83 Colorado State Planes, CO83-CF

Colorado Central FIPS 0502
(Feet)

Central Zone, US Foot
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Coordinate Systems for USA, Colorado (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Colorado NAD83 Colorado State Planes, CO83-N
North FIPS 0501 North Zone, Meter
NAD 1983 StatePlane NAD83 Colorado State Planes, CO83-NF
Colorado North FIPS 0501 (Feet)  North Zone, US Foot
NAD 1983 StatePlane Colorado NAD83 Colorado State Planes, CO83-S
South FIPS 0503 South Zone, Meter
NAD 1983 StatePlane NAD83 Colorado State Planes, CO83-SF
Colorado South FIPS 0503 (Feet)  South Zone, US Foot

USA, Connecticut

Coordinate Systems for USA, Connecticut
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Connecticut State Plane CT
Connecticut FIPS 0600 Zone, US Foot
NAD 1983 StatePlane NAD83 Connecticut State Plane CT83
Connecticut FIPS 0600 Zone, Meter
NAD 1983 StatePlane Connecti- NAD83 Connecticut State Plane CT83F

cut FIPS 0600 (Feet)

Zone, US Foot
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USA, Delaware

Coordinate Systems for USA, Delaware

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Delaware NAD27 Delaware State Planes, DE
FIPS 0700 US Foot
NAD 1983 StatePlane NAD83 Delaware State Planes, DE83
Delaware FIPS 0700 Meter
NAD 1983 StatePlane Delaware NAD83 Delaware State Planes, DE83F
FIPS 0700 (Feet) US Foot

USA, Florida

Coordinate Systems for USA, Florida
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Florida NAD27 Florida State Planes, East FL-E
East FIPS 0901 Zone, US Foot
NAD 1927 StatePlane Florida NAD?27 Florida State Planes, FL-N
North FIPS 0903 North Zone, US Foot
NAD 1927 StatePlane Florida NADZ27 Florida State Planes, FL-W
West FIPS 0902 West Zone, US Foot
NAD 1983 StatePlane Florida NADS83 Florida State Planes, East FL83-E
East FIPS 0901 Zone, Meter
NAD 1983 StatePlane Florida NADS83 Florida State Planes, FL83-N
North FIPS 0903 North Zone, Meter
NAD 1983 StatePlane Florida NADS83 Florida State Planes, FL83-W

West FIPS 0902

West Zone, Meter
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Coordinate Systems for USA, Florida (continued)

West FIPS 1002 (Feet)

West Zone, US Foot

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Florida NAD83 Florida State Planes, FL83-NF
North FIPS 0903 (Feet) North Zone, US Foot
NAD 1983 StatePlane Florida NADS83 Florida State Planes, East FL83-EF
East FIPS 0901 (Feet) Zone, US Foot
NAD 1983 StatePlane Florida NADS83 Florida State Planes, FL83-WF
West FIPS 0902 (Feet). West Zone, US Foot

USA, Georgia

Coordinate Systems for USA, Georgia
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Georgia NAD27 Georgia State Planes, GA-E
East FIPS 1001 East Zone, US Foot
NAD 1927 StatePlane Georgia NAD27 Georgia State Planes, GA-W
West FIPS 1002 West Zone, US Foot
NAD 1983 StatePlane Georgia NAD83 Georgia State Planes, GA83-E
East FIPS 1001 East Zone, Meter
NAD 1983 StatePlane Georgia NAD83 Georgia State Planes, GA83-W
West FIPS 1002 West Zone, Meter
NAD 1983 StatePlane Georgia NAD83 Georgia State Planes, GA83-EF
East FIPS 1001 (Feet) East Zone, US Foot
NAD 1983 StatePlane Georgia NAD83 Georgia State Planes, GA83-WF
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USA, Hawaii

Coordinate Systems for USA, Hawaii

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Hawaii 1 NAD27 Hawaii State Planes, HI-1
FIPS 5101 Zone 1, US Foot

Old Hawaiian StatePlane Hawaii

1 FIPS 5101

NAD 1927 StatePlane Hawaii 2 NAD27 Hawaii State Planes, HI-2
FIPS 5102 Zone 2, US Foot

Old Hawaiian StatePlane Hawaii

2 FIPS 5102

NAD 1927 StatePlane Hawaii 3 NAD27 Hawaii State Planes, HI-3
FIPS 5103 Zone 3, US Foot

Old Hawaiian StatePlane Hawaii

3 FIPS 5103

NAD 1927 StatePlane Hawaii 4 NAD27 Hawaii State Planes, HI-4
FIPS 5104 Zone 4, US Foot

Old Hawaiian StatePlane Hawaii

4 FIPS 5104

NAD 1927 StatePlane Hawaii 5 NAD27 Hawaii State Planes, HI-5
FIPS 5105 Zone 5, US Foot

Old Hawaiian StatePlane Hawaii

5 FIPS 5105

NAD 1983 StatePlane Hawaii 1 NAD83 Hawaii State Planes, HI83-1
FIPS 5101 Zone 1, Meter

NAD 1983 StatePlane Hawaii 1 NAD83 Hawaii State Planes, HI83-1F
FIPS 5101 (Feet) Zone 1, US Foot

NAD 1983 StatePlane Hawaii 2 NAD83 Hawaii State Planes, HI83-2
FIPS 5102 Zone 2, Meter

NAD 1983 StatePlane Hawaii 2 NAD83 Hawaii State Planes, HI83-2F

FIPS 5102 (Feet)

Zone 2, US Foot
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Coordinate Systems for USA, Hawaii (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Hawaii 3 NAD83 Hawaii State Planes, HI83-3
FIPS 5103 Zone 3, Meter
NAD 1983 StatePlane Hawaii 3 NAD83 Hawaii State Planes, HI83-3F
FIPS 5103 (Feet) Zone 3, US Foot
NAD 1983 StatePlane Hawaii 4 NAD83 Hawaii State Planes, HI83-4
FIPS 5104 Zone 4, Meter
NAD 1983 StatePlane Hawaii 4 NAD83 Hawaii State Planes, HI83-4F
FIPS 5104 (Feet) Zone 4, US Foot
NAD 1983 StatePlane Hawaii 5 NAD83 Hawaii State Planes, HI83-5
FIPS 5105 Zone 5, Meter
NAD 1983 StatePlane Hawaii 5 NAD83 Hawaii State Planes, HI83-5F
FIPS 5105 (Feet) Zone 5, US Foot

USA, Idaho

Coordinate Systems for USA, Idaho
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Idaho NAD27 Idaho State Planes, Cen-  ID-C
Central FIPS 1102 tral Zone, US Foot

NAD 1927 StatePlane Idaho East NAD27 Idaho State Planes, East ID-E

FIPS 1101 Zone, US Foot

NAD 1927 StatePlane Idaho NAD27 Idaho State Planes, West ID-W
West FIPS 1103 Zone, US Foot

NAD 1983 StatePlane Idaho NAD83 Idaho State Planes, Cen-  ID83-C
Central FIPS 1102 tral Zone, Meter

NAD 1983 StatePlane Idaho NAD83 Idaho State Planes, Cen-  ID83-CF
Central FIPS 1102 (Feet) tral Zone, US Foot

86 | Appendix A Matching SHP and MWF Coordinate Systems



Coordinate Systems for USA, Idaho (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Idaho East NAD83 Idaho State Planes, East ID83-E
FIPS 1101 Zone, Meter
NAD 1983 StatePlane Idaho East NAD83 Idaho State Planes, East ID83-EF
FIPS 1101 (Feet) Zone, US Foot
NAD 1983 StatePlane Idaho NAD83 Idaho State Planes, West ID83-W
West FIPS 1103 Zone, Meter
NAD 1983 StatePlane Idaho NAD83 Idaho State Planes, West ID83-WF
West FIPS 1103 (Feet) Zone, US Foot

USA, lllinois

Coordinate Systems for USA, lllinois
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane lllinois NAD27 lllinois State Planes, East IL-E
East FIPS 1201 Zone, US Foot
NAD 1927 StatePlane lllinois NAD27 lllinois State Planes, West  IL-W
West FIPS 1202 Zone, US Foot
NAD 1983 StatePlane lllinois NADS83 lllinois State Planes, East IL83-E
East FIPS 1201 Zone, Meter
NAD 1983 StatePlane lllinois NADS83 lllinois State Planes, East IL83-EF
East FIPS 1201 (Feet) Zone, US Foot
NAD 1983 StatePlane lllinois NADS83 lllinois State Planes, West ~ IL83-W
West FIPS 1202 Zone, Meter
NAD 1983 StatePlane lllinois NADS83 lllinois State Planes, West ~ 1L83-WF

West FIPS 1202 (Feet)

Zone, US Foot
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USA, Indiana

Coordinate Systems for USA, Indiana

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Indiana NAD27 Indiana State Planes, IN-E
East FIPS 1301 East Zone, US Foot
NAD 1927 StatePlane Indiana NAD27 Indiana State Planes, IN-W
West FIPS 1302 West Zone, US Foot
NAD 1983 StatePlane Indiana NAD83 Indiana State Planes, IN83-E
East FIPS 1301 East Zone, Meter
NAD 1983 StatePlane Indiana NAD83 Indiana State Planes, IN83-EF
East FIPS 1301 (Feet) East Zone, US Foot
NAD 1983 StatePlane Indiana NAD83 Indiana State Planes, IN83-W
West FIPS 1302 West Zone, Meter
NAD 1983 StatePlane Indiana NAD83 Indiana State Planes, IN83-WF
West FIPS 1302 (Feet) West Zone, US Foot

USA, lowa

Coordinate Systems for USA, lowa
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane lowa NAD27 lowa State Planes, North 1A-N
North FIPS 1401 Zone, US Foot
NAD 1927 StatePlane lowa NAD27 lowa State Planes, South 1A-S
South FIPS 1402 Zone, US Foot
NAD 1983 StatePlane lowa NAD83 lowa State Planes, North 1A83-N

North FIPS 1401

Zone, Meter
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Coordinate Systems for USA, lowa (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane lowa NAD83 lowa State Planes, North 1A83-NF
North FIPS 1401 (Feet) Zone, US Foot
NAD 1983 StatePlane lowa NAD83 lowa State Planes, South 1A83-S
South FIPS 1402 Zone, Meter
NAD 1983 StatePlane lowa NAD83 lowa State Planes, South 1A83-SF
South FIPS 1402 (Feet) Zone, US Foot

USA, Kansas

Coordinate Systems for USA, Kansas
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Kansas NAD27 Kansas State Planes, KS-N
North FIPS 1501 North Zone, US Foot
NAD 1927 StatePlane Kansas NAD27 Kansas State Planes, KS-S
South FIPS 1502 South Zone, US Foot
NAD 1983 StatePlane Kansas NAD83 Kansas State Planes, KS83-N
North FIPS 1501 North Zone, Meter
NAD 1983 StatePlane Kansas NAD83 Kansas State Planes, KS83-NF
North FIPS 1501 (Feet) North Zone, US Foot
NAD 1983 StatePlane Kansas NAD83 Kansas State Planes, KS83-S
South FIPS 1502 South Zone, Meter
NAD 1983 StatePlane Kansas NAD83 Kansas State Planes, KS83-SF

South FIPS 1502 (Feet)

South Zone, US Foot
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USA, Kentucky

Coordinate Systems for USA, Kentucky

Louisiana North FIPS 1701

North Zone, Meter

Appendix A Matching SHP and MWF Coordinate Systems

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Kentucky NAD27 Kentucky State Planes, KY-N
North FIPS 1601 North Zone, US Foot
NAD 1927 StatePlane Kentucky NAD27 Kentucky State Planes, KY-S
South FIPS 1602 South Zone, US Foot
NAD 1983 StatePlane Kentucky NAD83 Kentucky State Planes, KY83-N
North FIPS 1601 North Zone, Meter
NAD 1983 StatePlane Kentucky NAD83 Kentucky State Planes, KY83-NF
North FIPS 1601 (Feet) North Zone, US Foot
NAD 1983 StatePlane Kentucky NAD83 Kentucky State Planes, KY83-S
South FIPS 1602 South Zone, Meter
NAD 1983 StatePlane Kentucky NAD83 Kentucky State Planes, KY83-SF
South FIPS 1602 (Feet) South Zone, US Foot

USA, Louisiana

Coordinate Systems for USA, Louisiana
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Louisiana State Planes, LA-N
Louisiana North FIPS 1701 North Zone, US Foot
NAD 1927 StatePlane NAD27 Louisiana State Planes, LA-S
Louisiana South FIPS 1702 South Zone, US Foot
NAD 1983 StatePlane NAD83 Louisiana State Planes, LA83-N



Coordinate Systems for USA, Louisiana (continued)

West FIPS 1802 (Feet)

Zone, US Foot

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane NAD83 Louisiana State Planes, LA83-NF
Louisiana North FIPS 1701 (Feet)  North Zone, US Foot
NAD 1983 StatePlane NAD83 Louisiana State Planes, LA83-S
Louisiana South FIPS 1702 South Zone, Meter
NAD 1983 StatePlane NAD83 Louisiana State Planes, LA83-SF
Louisiana South FIPS 1702 (Feet)  South Zone, US Foot

USA, Maine

Coordinate Systems for USA, Maine
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Maine NAD27 Maine State Planes, East ME-E
East FIPS 1801 Zone, US Foot
NAD 1927 StatePlane Maine NAD27 Maine State Planes, West ~ ME-W
West FIPS 1802 Zone, US Foot
NAD 1983 StatePlane Maine NAD83 Maine State Planes, East ME83-E
East FIPS 1801 Zone, Meter
NAD 1983 StatePlane Maine NAD83 Maine State Planes, East MES83-EF
East FIPS 1801 (Feet) Zone, US Foot
NAD 1983 StatePlane Maine NAD83 Maine State Planes, West ME83-W
West FIPS 1802 Zone, Meter
NAD 1983 StatePlane Maine NAD83 Maine State Planes, West ~ ME83-WF
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USA, Maryland

Coordinate Systems for USA, Maryland

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Maryland State Plane MD
Maryland FIPS 1900 Zone, US Foot
NAD 1983 StatePlane NAD83 Maryland State Plane MD83
Maryland FIPS 1900 Zone, Meter
NAD 1983 StatePlane NAD83 Maryland State Plane MD83F
Maryland FIPS 1900 (Feet) Zone, US Foot
USA, Massachusetts
Coordinate Systems for USA, Massachusetts

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Massachusetts State MA
Massachusetts Mainland FIPS Planes, Mainland Zone, US Foot
2001
NAD 1927 StatePlane Massachu-  Possible match to NAD27 Mas- MA-IS
setts Island FIPS 2002 sachusetts State Planes, Island

Zone, US Foot
NAD 1983 StatePlane NAD83 Massachusetts State MAS83-IS
Massachusetts Island FIPS 2002 Planes, Island Zone, Meter
NAD 1983 StatePlane NAD83 Massachusetts State MAB83-ISF
Massachusetts Island FIPS 2002 Planes, Island Zone, US Foot
(Feet)
NAD 1983 StatePlane NAD83 Massachusetts State MA83
Massachusetts Mainland FIPS Planes, Mainland Zone, Meter
2001
NAD 1983 StatePlane Massachu-  NAD83 Massachusetts State MAB83F

setts Mainland FIPS 2001 (Feet)

Planes, Mainland Zone, US
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USA, Michigan

Coordinate Systems for USA, Michigan

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Michigan State Planes, MI-C
Michigan Central FIPS 2112 Central Zone, US Foot

NAD 1927 StatePlane NAD27 Michigan State Planes, MI-N
Michigan North FIPS 2111 North Zone, US Foot

NAD 1927 StatePlane NAD27 Michigan State Planes, MI-S
Michigan South FIPS 2113 South Zone, US Foot

NAD Michigan StatePlane Michi-  Old Michigan SPCS, West Zone, MI-OW
gan West Old FIPS 2103 Elevated Ellipsoid, US Foot

NAD Michigan StatePlane Michi-  Old Michigan SPCS, Central MI-OC
gan Central Old FIPS 2102 Zone, Elevated Ellipsoid, US Foot

NAD Michigan StatePlane Michi-  Old Michigan SPCS, East Zone, MI-OE
gan East Old FIPS 2101 Elevated Ellipsoid, US Foot

NAD Michigan StatePlane Michi-  None None
gan North FIPS 2111

NAD 1983 StatePlane Michigan NAD83 Michigan State Planes, MI83-NF
North FIPS 2111 (Feet) North Zone, US Foot

NAD Michigan StatePlane Michi-  None None
gan Central FIPS 2112

NAD Michigan StatePlane Michi-  None None
gan South FIPS 2113

NAD 1983 StatePlane NAD83 Michigan State Planes, MI83-C
Michigan Central FIPS 2202 Central Zone, Meter

NAD 1983 StatePlane NAD83 Michigan State Planes, MI83-CF

Michigan Central FIPS 2202
(Feet)

Central Zone, US Foot
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Coordinate Systems for USA, Michigan (continued)

Central FIPS 2202

Central Zone, Meter

Appendix A Matching SHP and MWF Coordinate Systems

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane NAD83 Michigan State Planes, MI83-N
Michigan North FIPS 2111 North Zone, Meter
NAD 1983 StatePlane NAD83 Michigan State Planes, MI83-S
Michigan South FIPS 2113 South Zone, Meter
NAD 1983 StatePlane Michigan NAD83 Michigan State Planes, MI83-SF
South FIPS 2113 (Feet) South Zone, US Foot

USA, Minnesota

Coordinate Systems for USA, Minnesota
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Minnesota NAD27 Minnesota State Planes, MN-N
North FIPS 2201 North Zone, US Foot
NAD 1927 StatePlane NAD27 Minnesota State Planes, MN-C
Minnesota Central FIPS 2202 Central Zone, US Foot
NAD 1927 StatePlane NAD27 Minnesota State Planes, MN-S
Minnesota South FIPS 2203 South, US Foot
NAD 1983 StatePlane Minnesota NAD83 Minnesota State Planes, MN83-N
North FIPS 2201 North Zone, Meter
NAD 1983 StatePlane Minnesota NAD83 Minnesota State Planes, MN83-NF
North FIPS 2201 (Feet) North Zone, US Foot
NAD 1983 StatePlane Minnesota NAD83 Minnesota State Planes, MN83-C



Coordinate Systems for USA, Minnesota (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Minnesota NAD83 Minnesota State Planes, MN83-CF
Central FIPS 2202 (Feet) Central Zone, US Foot
NAD 1983 StatePlane Minnesota NAD83 Minnesota State Planes, MN83-S
South FIPS 2203 South Zone, Meter
NAD 1983 StatePlane Minnesota NAD83 Minnesota State Planes, MN83-SF
South FIPS 2203 (Feet) South Zone, US Foot

USA, Mississippi

Coordinate Systems for USA, Mississippi
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Mississippi State Planes, MS-E
Mississippi East FIPS 2301 East Zone, US Foot, CORRECTED
NAD 1927 StatePlane NADZ27 Mississippi State Planes, MS-W
Mississippi West FIPS 2302 West Zone, US Foot
NAD 1983 StatePlane Mississippi ~ NAD83 Mississippi State Planes, MS83-E
East FIPS 2301 East Zone, Meter
NAD 1983 StatePlane Mississippi ~ NAD83 Mississippi State Planes, MS83-EF
East FIPS 2301 (Feet) East Zone, US Foot
NAD 1983 StatePlane Mississippi  NAD83 Mississippi State Planes, MS83-W
West FIPS 2302 West Zone, Meter
NAD 1983 StatePlane Mississippi ~ NAD83 Mississippi State Planes, MS83-WF

West FIPS 2302 (Feet)

West Zone, US Foot
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USA, Missouri

Coordinate Systems for USA, Missouri

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Missouri NAD27 Missouri State Planes, MO-C
Central FIPS 2402 Central Zone, US Foot

NAD 1927 StatePlane Missouri NAD27 Missouri State Planes, MO-E
East FIPS 2401 East Zone, US Foot

NAD 1927 StatePlane Missouri NAD27 Missouri State Planes, MO-W
West FIPS 2403 West Zone, US Foot

NAD 1983 StatePlane Missouri NAD83 Missouri State Planes, MO83-C
Central FIPS 2402 Central Zone, Meter

NAD 1983 StatePlane Missouri NAD83 Missouri State Planes, MO83-CF
Central FIPS 2402 (Feet) Central Zone, US Foot

NAD 1983 StatePlane Missouri NAD83 Missouri State Planes, MOB83-E
East FIPS 2401 East Zone, Meter

NAD 1983 StatePlane Missouri NAD83 Missouri State Planes, MOB83-EF
East FIPS 2401 (Feet) East Zone, US Foot

NAD 1983 StatePlane Missouri NAD83 Missouri State Planes, MO83-W
West FIPS 2403 West Zone, Meter

NAD 1983 StatePlane Missouri NAD83 Missouri State Planes, MO83-WF

West FIPS 2403 (Feet)

West Zone, US Foot
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USA, Montana

Coordinate Systems for USA, Montana

FIPS 2600 (Feet)

US Foot

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Montana NAD27 Montana State Planes, MT-C
Central FIPS 2502 Central Zone, US Foot
NAD 1927 StatePlane Montana NAD27 Montana State Planes, MT-N
North FIPS 2501 North Zone, US Foot
NAD 1927 StatePlane Montana NAD27 Montana State Planes, MT-S
South FIPS 2503 South Zone, US Foot
NAD 1983 StatePlane Montana NAD83 Montana State Plane MT83
FIPS 2500 Zone, Meter
NAD 1983 StatePlane Montana NAD83 Montana State Plane MT83F
FIPS 2500 (Feet) Zone, US Foot

USA, Nebraska

Coordinate Systems for USA, Nebraska
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Nebraska NAD27 Nebraska State Planes, NE-N
North FIPS 2601 North Zone, US Foot
NAD 1927 StatePlane Nebraska NAD27 Nebraska State Planes, NE-S
South FIPS 2602 South Zone, US Foot
NAD 1983 StatePlane Nebraska NAD83 Nebraska State Planes, NE83
FIPS 2600 Meter
NAD 1983 StatePlane Nebraska NAD83 Nebraska State Planes, NE83F
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USA, Nevada

Coordinate Systems for USA, Nevada

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Nevada NAD27 Nevada State Planes, NV-C
Central FIPS 2702 Central Zone, US Foot

NAD 1927 StatePlane Nevada NAD27 Nevada State Planes, NV-E

East FIPS 2701 East Zone, US Foot

NAD 1927 StatePlane Nevada NAD27 Nevada State Planes, NV-W
West FIPS 2703 West Zone, US Foot

NAD 1983 StatePlane Nevada NAD83 Nevada State Planes, NV83-C
Central FIPS 2702 Central Zone, Meter

NAD 1983 StatePlane Nevada NAD83 Nevada State Planes, NV83-CF
Central FIPS 2702 (Feet) Central Zone, US Foot

NAD 1983 StatePlane Nevada NAD83 Nevada State Planes, NV83-E
East FIPS 2701 East Zone, Meter

NAD 1983 StatePlane Nevada NAD83 Nevada State Planes, NV83-EF
East FIPS 2701 (Feet) East Zone, US Foot

NAD 1983 StatePlane Nevada NAD83 Nevada State Planes, NV83-W
West FIPS 2703 West Zone, Meter

NAD 1983 StatePlane Nevada NAD83 Nevada State Planes, NV83-WF

West FIPS 2703 (Feet)

West Zone, US Foot
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USA, New Hampshire

Coordinate Systems for USA, New Hampshire

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane New NAD27 New Hampshire State NH
Hampshire FIPS 2800 Planes, US Foot
NAD 1983 StatePlane New NAD83 New Hampshire State NH83
Hampshire FIPS 2800 Planes, Meter
NAD 1983 StatePlane New NAD83 New Hampshire State NH83F
Hampshire FIPS 2800 (Feet) Planes, US Foot

USA, New Jersey

Coordinate Systems for USA, New Jersey
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 New Jersey State Planes, NJ
New Jersey FIPS 2900 US Foot
NAD 1983 StatePlane NAD83 New Jersey State Planes, NJ83
New Jersey FIPS 2900 Meter
NAD 1983 StatePlane New Jer- NAD83 New Jersey State Planes, NJ83F

sey FIPS 2900 (Feet)

US Foot
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USA, New Mexico

Coordinate Systems for USA, New Mexico

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane New Mex- NAD27 New Mexico State NM-C

ico Central FIPS 3002 Planes, Central Zone, US Foot

NAD 1927 StatePlane New Mex-  NAD27 New Mexico State NM-E

ico East FIPS 3001 Planes, East Zone, US Foot

NAD 1927 StatePlane New Mex- NAD27 New Mexico State NM-W
ico West FIPS 3003 Planes, West Zone, US Foot

NAD 1983 StatePlane New Mex-  NAD83 New Mexico State NM83-C
ico Central FIPS 3002 Planes, Central Zone, Meter

NAD 1983 StatePlane New Mex- NAD83 New Mexico State NM83-CF
ico Central FIPS 3002 (Feet) Planes, Central Zone, US Foot

NAD 1983 StatePlane New Mex-  NAD83 New Mexico State NM83-E
ico East FIPS 3001 Planes, East Zone, Meter

NAD 1983 StatePlane New Mex- NAD83 New Mexico State NMS83-EF
ico East FIPS 3001 (Feet) Planes, East Zone, US Foot

NAD 1983 StatePlane New Mex-  NAD83 New Mexico State NM83-W
ico West FIPS 3003 Planes, West Zone, Meter

NAD 1983 StatePlane New Mex- NAD83 New Mexico State NM83-WF

ico West FIPS 3003 (Feet)

Planes, West Zone, US Foot
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USA, New York

Coordinate Systems for USA, New York

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane New York NAD27 New York State Planes, NY-C
Central FIPS 3102 Central Zone, US Foot

NAD 1927 StatePlane New York NAD27 New York State Planes, NY-E
East FIPS 3101 East Zone, US Foot

NAD 1927 StatePlane New York NAD27 New York State Planes, NY-LI
Long Island FIPS 3104 Long Island, US Foot

NAD 1927 StatePlane New York NAD27 New York State Planes, NY-W
West FIPS 3103 West Zone, US Foot

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-E
East FIPS 3101 East Zone, Meter

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-EF
East FIPS 3101 (Feet) East Zone, US Foot

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-C
Central FIPS 3102 Central Zone, Meter

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-C
Central FIPS 3102 (Feet) Central Zone, Meter

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-LI
Long Island FIPS 3104 Long Island, Meter

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-LIF
Long Island FIPS 3104 (Feet) Long Island, US Foot

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-W
West FIPS 3103 West Zone, Meter

NAD 1983 StatePlane New York NAD83 New York State Planes, NY83-WF

West FIPS 3103 (Feet)

West Zone, US Foot

Matching Coordinate Systems | 101



USA, North Carolina

Coordinate Systems for USA, North Carolina

Dakota South FIPS 3302 (Feet)

Planes, South Zone, US Foot

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane North NAD27 North Carolina State NC
Carolina FIPS 3200 Planes, US Foot
NAD 1983 StatePlane North NAD83 North Carolina State NC83F
Carolina FIPS 3200 (Feet) Planes, US Foot
NAD 1983 StatePlane North NAD83 North Carolina State NC83
Carolina FIPS 3200 Planes, Meter

USA, North Dakota

Coordinate Systems for USA, North Dakota
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane North NAD27 North Dakota State ND-N
Dakota North FIPS 3301 Planes, North Zone, US Foot
NAD 1927 StatePlane North NAD27 North Dakota State ND-S
Dakota South FIPS 3302 Planes, South Zone, US Foot
NAD 1983 StatePlane North NAD83 North Dakota State ND83-N
Dakota North FIPS 3301 Planes, North Zone, Meter
NAD 1983 StatePlane North NAD83 North Dakota State ND83-NF
Dakota North FIPS 3301 (Feet) Planes, North Zone, US Foot
NAD 1983 StatePlane North NAD83 North Dakota State ND83-S
Dakota South FIPS 3302 Planes, South Zone, Meter
NAD 1983 StatePlane North NAD83 North Dakota State ND83-SF
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USA, Ohio

Coordinate Systems for USA, Ohio

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Ohio NAD27 Ohio State Planes, North OH-N
North FIPS 3401 Zone, US Foot
NAD 1927 StatePlane Ohio NAD27 Ohio State Planes, South OH-S
South FIPS 3402 Zone, US Foot
NAD 1983 StatePlane Ohio NAD83 Ohio State Planes, North OH83-N
North FIPS 3401 Zone, Meter
NAD 1983 StatePlane Ohio NAD83 Ohio State Planes, North OHB83-NF
North FIPS 3401 (Feet) Zone, US Foot
NAD 1983 StatePlane Ohio NAD83 Ohio State Planes, South OH83-S
South FIPS 3402 Zone, Meter
NAD 1983 StatePlane Ohio NAD83 Ohio State Planes, South OH83-SF
South FIPS 3402 (Feet) Zone, US Foot

USA, Oklahoma

Coordinate Systems for USA, Oklahoma
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Oklahoma State Planes, OK-N
Oklahoma North FIPS 3501 North Zone, US Foot
NAD 1927 StatePlane NAD27 Oklahoma State Planes, OK-S
Oklahoma South FIPS 3502 South Zone, US Foot
NAD 1983 StatePlane NAD83 Oklahoma State Planes, OK83-N

Oklahoma North FIPS 3501

North Zone, Meter
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Coordinate Systems for USA, Oklahoma (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane NAD83 Oklahoma State Planes, OK83-NF
Oklahoma North FIPS 3501 North Zone, US Foot
(Feet)
NAD 1983 StatePlane NAD83 Oklahoma State Planes, OK83-S
Oklahoma South FIPS 3502 South Zone, Meter
NAD 1983 StatePlane NAD83 Oklahoma State Planes, OK83-SF
Oklahoma South FIPS 3502 South Zone, US Foot
(Feet)
USA, Oregon
Coordinate Systems for USA, Oregon

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Oregon NAD27 Oregon State Planes OR-N
North FIPS 3601 (Polyconic), North Zone, US

Foot
NAD 1927 StatePlane Oregon NAD27 Oregon State Planes OR-S
South FIPS 3602 (Polyconic), South Zone, US

Foot
NAD 1983 StatePlane Oregon NAD&83 Oregon State Planes OR83-N
North FIPS 3601 (Polyconic), North Zone, Meter
NAD 1983 StatePlane Oregon NAD83 Oregon State Planes OR83-NF
North FIPS 3601 (Feet) (Polyconic), North Zone, US

Foot
NAD 1983 StatePlane Oregon NAD83 Oregon State Planes OR83-S
South FIPS 3602 (Polyconic), South Zone, Meter
NAD 1983 StatePlane Oregon NAD83 Oregon State Planes OR83-SF

South FIPS 3602 (Feet)

(Polyconic), South Zone, US
Foot
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USA, Pennsylvania

Coordinate Systems for USA, Pennsylvania

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Pennsylvania State PA-N
Pennsylvania North FIPS 3701 Planes, North Zone, US Foot
NAD 1927 StatePlane NAD27 Pennsylvania State PA-S
Pennsylvania South FIPS 3702 Planes, South Zone, US Foot
NAD 1983 StatePlane Pennsylva-  NAD83 Pennsylvania State PA83-N
nia North FIPS 3701 Planes, North Zone, Meter
NAD 1983 StatePlane NAD83 Pennsylvania State PA83-NF
Pennsylvania North FIPS 3701 Planes, North Zone, US Foot
(Feet)
NAD 1983 StatePlane NAD83 Pennsylvania State PA83-S
Pennsylvania South FIPS 3702 Planes, South Zone, Meter
NAD 1983 StatePlane NAD83 Pennsylvania State PA83-SF
Pennsylvania South FIPS 3702 Planes, South Zone, US Foot
(Feet)

USA, Rhode Island

Coordinate Systems for USA, Rhode Island
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Rhode NAD27 Rhode Island State RI
Island FIPS 3800 Planes, US Foot
NAD 1983 StatePlane Rhode NADG83 Rhode Island State RI83
Island FIPS 3800 Planes, Meter
NAD 1983 StatePlane Rhode NAD83 Rhode Island State RI83F

Island FIPS 3800 (Feet)

Planes, US Foot
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USA, South Carolina

Coordinate Systems for USA, South Carolina

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane South NAD27 South Carolina State SC-N
Carolina North FIPS 3901 Planes, North Zone, US Foot
NAD 1927 StatePlane South NAD27 South Carolina State SC-S
Carolina South FIPS 3902 Planes, South Zone, US Foot
NAD 1983 StatePlane South NAD83 South Carolina State SC83
Carolina FIPS 3900 Planes, Meter
NAD 1983 StatePlane South NADB83 South Carolina State SC83F
Carolina FIPS 3900 (Feet) Planes, US Foot

USA, South Dakota

Coordinate Systems for USA, South Dakota
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane South NAD27 South Dakota State SD-N
Dakota North FIPS 4001 Planes, North Zone, US Foot
NAD 1927 StatePlane South NAD27 South Dakota State SD-S
Dakota South FIPS 4002 Planes, South Zone, US Foot
NAD 1983 StatePlane South NADA83 South Dakota State SD83-N
Dakota North FIPS 4001 Planes, North Zone, Meter
NAD 1983 StatePlane South NAD83 South Dakota State SD83-NF
Dakota North FIPS 4001 (Feet) Planes, North Zone, US Foot
NAD 1983 StatePlane South NADB83 South Dakota State SD83-S
Dakota South FIPS 4002 Planes, South Zone, Meter
NAD 1983 StatePlane South NAD83 South Dakota State SD83-SF

Dakota South FIPS 4002 (Feet)

Planes, South Zone, US Foot
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USA, Tennessee

Coordinate Systems for USA, Tennessee

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Tennessee State Plane TN
Tennessee FIPS 4100 Zone, US Foot
NAD 1983 StatePlane NAD83 Tennessee State Plane TN83
Tennessee FIPS 4100 Zone, Meter
NAD 1983 StatePlane NAD@83 Tennessee State Plane TN83F
Tennessee FIPS 4100 (Feet) Zone, US Foot

USA, Texas

Coordinate Systems for USA, Texas
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Texas NAD27 Texas State Planes, Cen- TX-C
Central FIPS 4203 tral Zone, US Foot
NAD 1927 StatePlane Texas NAD27 Texas State Planes, TX-NC
North Central FIPS 4202 North Central Zone, US Foot
NAD 1927 StatePlane Texas NAD27 Texas State Planes, TX-N
North FIPS 4201 North Zone, US Foot
NAD 1927 StatePlane Texas NAD27 Texas State Planes, TX-SC
South Central FIPS 4204 South Central Zone, US Foot
NAD 1927 StatePlane Texas NAD27 Texas State Planes, TX-S
South FIPS 4205 South Zone, US Foot
NAD 1983 StatePlane Texas NAD83 Texas State Planes, Cen- TX83-C
Central FIPS 4203 tral Zone, Meter
NAD 1983 StatePlane Texas NAD83 Texas State Planes, Cen- TX83-CF
Central FIPS 4203 (Feet) tral Zone, US Foot
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Coordinate Systems for USA, Texas (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-NC
North Central FIPS 4202 North Central Zone, Meter
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-NCF
North Central FIPS 4202 (Feet) North Central Zone, US Foot
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-N
North FIPS 4201 North Zone, Meter
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-SC
South Central FIPS 4204 South Central Zone, Meter
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-SCF
South Central FIPS 4204 (Feet) South Central Zone, US Foot
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-S
South FIPS 4205 South Zone, Meter
NAD 1983 StatePlane Texas NAD83 Texas State Planes, TX83-SF
South FIPS 4205 (Feet) South Zone, US Foot

USA, Utah

Coordinate Systems for USA, Utah
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Utah Cen-  NAD27 Utah State Planes, Cen- UT-C
tral FIPS 4302 tral Zone, US Foot
NAD 1927 StatePlane Utah NAD27 Utah State Planes, North UT-N
North FIPS 4301 Zone, US Foot
NAD 1927 StatePlane Utah NAD27 Utah State Planes, South UT-S
South FIPS 4303 Zone, US Foot
NAD 1983 StatePlane Utah Cen-  NAD83 Utah State Planes, Cen- uT83-C

tral FIPS 4302

tral Zone, Meter

108 | Appendix A Matching SHP and MWF Coordinate Systems



Coordinate Systems for USA, Utah (continued)

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane Utah Cen-  NADS83 Utah State Planes, Cen- UT83-CF
tral FIPS 4302 (Feet) tral Zone, US Foot
NAD 1983 StatePlane Utah NAD83 Utah State Planes, North UT83-N
North FIPS 4301 Zone, Meter
NAD 1983 StatePlane Utah NAD83 Utah State Planes, North UT83-NF
North FIPS 4301 (Feet) Zone, US Foot
NAD 1983 StatePlane Utah NAD83 Utah State Planes, South uT83-S
South FIPS 4303 Zone, Meter
NAD 1983 StatePlane Utah NAD83 Utah State Planes, South UT83-SF
South FIPS 4303 (Feet) Zone, US Foot

USA, Vermont

Coordinate Systems for USA, Vermont
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Vermont NAD27 Vermont State Planes, VT
FIPS 3400 US Foot
NAD 1983 StatePlane Vermont NAD83 Vermont State Planes, VT83
FIPS 4400 Meter
NAD 1983 StatePlane Vermont NAD83 Vermont State Planes, VT83F
FIPS 4400 (Feet) US Foot
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USA, Virginia

Coordinate Systems for USA, Virginia

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane Virginia NAD27 Virginia State Planes, VA-N
North FIPS 4501 North Zone, US Foot
NAD 1927 StatePlane Virginia NAD27 Virginia State Planes, VA-S
South FIPS 4502 South Zone, US Foot
NAD 1983 StatePlane Virginia NADS83 Virginia State Planes, VA83-N
North FIPS 4501 North Zone, Meter
NAD 1983 StatePlane Virginia NAD83 Virginia State Planes, VA83-NF
North FIPS 4501 (Feet) North Zone, US Foot
NAD 1983 StatePlane Virginia NADS83 Virginia State Planes, VA83-S
South FIPS 4502 South Zone, Meter
NAD 1983 StatePlane Virginia NAD83 Virginia State Planes, VA83-SF
South FIPS 4502 (Feet) South Zone, US Foot

USA, Washington

Coordinate Systems for USA, Washington
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Washington State WA-N
Washington North FIPS 4601 Planes, North Zone, US Foot
NAD 1927 StatePlane NAD27 Washington State WA-S
Washington South FIPS 4602 Planes, South Zone, US Foot
NAD 1983 StatePlane NAD83 Washington State WA83-N

Washington North FIPS 4601

Planes, North Zone, Meter
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Coordinate Systems for USA, Washington (continued)

West Virginia South FIPS 4702
(Feet)

Planes, South Zone, US Foot

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1983 StatePlane NAD83 Washington State WAB83-NF
Washington North FIPS 4601 Planes, North Zone, US Foot
(Feet)
NAD 1983 StatePlane NAD83 Washington State WA83-S
Washington South FIPS 4602 Planes, South Zone, Meter
NAD 1983 StatePlane NAD83 Washington State WAB83-SF
Washington South FIPS 4602 Planes, South Zone, US Foot
(Feet)

USA, West Virginia

Coordinate Systems for USA, West Virginia
SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 West Virginia State WV-N
West Virginia North FIPS 4701 Planes, North Zone, US Foot
NAD 1927 StatePlane NAD27 West Virginia State WV-S
West Virginia South FIPS 4702 Planes, South Zone, US Foot
NAD 1983 StatePlane NAD83 West Virginia State WV83-N
West Virginia North FIPS 4701 Planes, North Zone, Meter
NAD 1983 StatePlane NAD83 West Virginia State WV83-NF
West Virginia North FIPS 4701 Planes, North Zone, US Foot
(Feet)
NAD 1983 StatePlane NAD83 West Virginia State WV83-S
West Virginia South FIPS 4702 Planes, South Zone, Meter
NAD 1983 StatePlane NAD83 West Virginia State WV83-SF
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USA, Wisconsin

Coordinate Systems for USA, Wisconsin

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Wisconsin State Planes, WI-C
Wisconsin Central FIPS 4802 Central Zone, US Foot

NAD 1927 StatePlane NAD27 Wisconsin State Planes, WI-N
Wisconsin North FIPS 4801 North Zone, US Foot

NAD 1927 StatePlane NAD27 Wisconsin State Planes, WI-S
Wisconsin South FIPS 4803 South Zone, US Foot

NAD 1983 StatePlane NAD83 Wisconsin State Planes, WI83-C
Wisconsin Central FIPS 4802 Central Zone, Meter

NAD 1983 StatePlane NAD83 Wisconsin State Planes, WI83-CF
Wisconsin Central FIPS 4802 Central Zone, US Foot

(Feet)

NAD 1983 StatePlane NAD83 Wisconsin State Planes, WI83-N
Wisconsin North FIPS 4801 North Zone, Meter

NAD 1983 StatePlane NAD83 Wisconsin State Planes, WI83-NF
Wisconsin North FIPS 4801 North Zone, US Foot

(Feet)

NAD 1983 StatePlane NAD83 Wisconsin State Planes, WI83-S
Wisconsin South FIPS 4803 South Zone, Meter

NAD 1983 StatePlane NAD83 Wisconsin State Planes, WI83-SF
Wisconsin South FIPS 4803 South Zone, US Foot

(Feet)
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USA, Wyoming

Coordinate Systems for USA, Wyoming

SHP Coordinate System MWEF Coordinate System CS Code
NAD 1927 StatePlane NAD27 Wyoming State Planes, WY-EC
Wyoming East Central FIPS 4902  East Central Zone, US Foot

NAD 1927 StatePlane NAD27 Wyoming State Planes, WY-E
Wyoming East FIPS 4901 East Zone, US Foot

NAD 1927 StatePlane NAD27 Wyoming State Planes, WY-WC
Wyoming West Central FIPS West Central Zone, US Foot

4903

NAD 1927 StatePlane NAD27 Wyoming State Planes, WY-W
Wyoming West FIPS 4904 West Zone, US Foot

NAD 1983 StatePlane Wyoming NAD83 Wyoming State Planes, WY83-EF
East FIPS 4901 (Feet) East, US Foot

NAD 1983 StatePlane NAD83 Wyoming State Planes, WY83-E
Wyoming East FIPS 4901 East, Meter

NAD 1983 StatePlane NAD83 Wyoming State Planes, WY83-EC
Wyoming East Central FIPS 4902  East Central Zone, Meter

NAD 1983 StatePlane NAD83 Wyoming State Planes, WY83-ECF
Wyoming East Central FIPS 4902  East Central Zone, US Foot

(Feet)

NAD 1983 StatePlane NAD83 Wyoming State Planes, WY83-WC
Wyoming West Central FIPS West Central Zone, Meter

4903

NAD 1983 StatePlane NAD83 Wyoming State Planes, WY83-WCF
Wyoming West Central FIPS West Central Zone, US Foot

4903 (Feet)

NAD 1983 StatePlane NAD83 Wyoming State Planes, WY83-W
Wyoming West FIPS 4904 West Zone, Meter

NAD 1983 StatePlane Wyoming NAD83 Wyoming State Planes, WY83-WF

West FIPS 4904 (Feet)

West Zone, US Foot
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UTM WGS 1984

Coordinate Systems for UTM WGS 1984

SHP Coordinate System

MWEF Coordinate System

CS Code

WGS 1984 UTM Zone TN

WGS 1984, UTM Zone 1 North,
Meter

UTM84-1N

WGS 1984 UTM Zone 1S

WGS 1984, UTM Zone 1 South,
Meter

UTM84-1S

WGS 1984 UTM Zone 2N

WGS 1984, UTM Zone 2 North,
Meter

UTM84-2N

WGS 1984 UTM Zone 2S

WGS 1984, UTM Zone 2 South,
Meter

UTM84-2S

WGS 1984 UTM Zone 3N

WGS 1984, UTM Zone 3 North,
Meter

UTM84-3N

WGS 1984 UTM Zone 3S

WGS 1984, UTM Zone 3 South,
Meter

UTM84-3S

WGS 1984 UTM Zone 4N

WGS 1984, UTM Zone 4 North,
Meter

UTM84-4N

WGS 1984 UTM Zone 4S

WGS 1984, UTM Zone 4 South,
Meter

UTM84-4S

WGS 1984 UTM Zone 5N

WGS 1984, UTM Zone 5 North,
Meter

UTM84-5N

WGS 1984 UTM Zone 5S

WGS 1984, UTM Zone 5 South,
Meter

UTM84-5S

WGS 1984 UTM Zone 6N

WGS 1984, UTM Zone 6 North,
Meter

UTM84-6N

WGS 1984 UTM Zone 6S

WGS 1984, UTM Zone 6 South,
Meter

UTM84-65

WGS 1984 UTM Zone 7N

WGS 1984, UTM Zone 7 North,
Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code

WGS 1984 UTM Zone 7S WGS 1984, UTM Zone 7 South, UTM84-7S
Meter

WGS 1984 UTM Zone 8N WGS 1984, UTM Zone 8 North, UTM84-8N
Meter

WGS 1984 UTM Zone 8S WGS 1984, UTM Zone 8 South, UTM84-8S
Meter

WGS 1984 UTM Zone 9N WGS 1984, UTM Zone 9 North, UTM84-9N
Meter

WGS 1984 UTM Zone 95 WGS 1984, UTM Zone 9 South, UTM84-9S
Meter

WGS 1984 UTM Zone 10N WGS 1984, UTM Zone 10 UTM84-10N
North, Meter

WGS 1984 UTM Zone 10S WGS 1984, UTM Zone 10 UTM84-10S
South, Meter

WGS 1984 UTM Zone 11N WGS 1984, UTM Zone 11 UTM84-11N
North, Meter

WGS 1984 UTM Zone 11S WGS 1984, UTM Zone 11 UTM84-11S
South, Meter

WGS 1984 UTM Zone 12N WGS 1984, UTM Zone 12 UTM84-12N
North, Meter

WGS 1984 UTM Zone 12S WGS 1984, UTM Zone 12 UTM84-12S
South, Meter

WGS 1984 UTM Zone 13N WGS 1984, UTM Zone 13 UTM84-13N
North, Meter

WGS 1984 UTM Zone 13S WGS 1984, UTM Zone 13 UTM84-13S
South, Meter

WGS 1984 UTM Zone 14N WGS 1984, UTM Zone 14 UTM84-14N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 14S WGS 1984, UTM Zone 14 UTM84-14S
South, Meter
WGS 1984 UTM Zone 15N WGS 1984, UTM Zone 15 UTM84-15N
North, Meter
WGS 1984 UTM Zone 158 WGS 1984, UTM Zone 15 UTM84-15S
South, Meter
WGS 1984 UTM Zone 16N WGS 1984, UTM Zone 16 UTM84-16N
North, Meter
WGS 1984 UTM Zone 16S WGS 1984, UTM Zone 16 UTM84-16S
South, Meter
WGS 1984 UTM Zone 17N WGS 1984, UTM Zone 17 UTM84-17N
North, Meter
WGS 1984 UTM Zone 175 WGS 1984, UTM Zone 17 UTM84-17S
South, Meter
WGS 1984 UTM Zone 18N WGS 1984, UTM Zone 18 UTM84-18N
North, Meter
WGS 1984 UTM Zone 18S WGS 1984, UTM Zone 18 UTM84-18S
South, Meter
WGS 1984 UTM Zone 19N WGS 1984, UTM Zone 19 UTM84-19N
North, Meter
WGS 1984 UTM Zone 19S WGS 1984, UTM Zone 19 UTM84-19S
South, Meter
WGS 1984 UTM Zone 20N WGS 1984, UTM Zone 20 UTM84-20N
North, Meter
WGS 1984 UTM Zone 20S WGS 1984, UTM Zone 20 UTM84-20S
South, Meter
WGS 1984 UTM Zone 21N WGS 1984, UTM Zone 21 UTM84-21N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 21S WGS 1984, UTM Zone 21 UTM84-21S
South, Meter
WGS 1984 UTM Zone 22N WGS 1984, UTM Zone 22 UTM84-22N
North, Meter
WGS 1984 UTM Zone 22S WGS 1984, UTM Zone 22 UTM84-22S
South, Meter
WGS 1984 UTM Zone 23N WGS 1984, UTM Zone 23 UTM84-23N
North, Meter
WGS 1984 UTM Zone 23S WGS 1984, UTM Zone 23 UTM84-23S
South, Meter
WGS 1984 UTM Zone 24N WGS 1984, UTM Zone 24 UTM84-24N
North, Meter
WGS 1984 UTM Zone 24S WGS 1984, UTM Zone 24 UTM84-24S
South, Meter
WGS 1984 UTM Zone 25N WGS 1984, UTM Zone 25 UTM84-25N
North, Meter
WGS 1984 UTM Zone 25S WGS 1984, UTM Zone 25 UTM84-25S
South, Meter
WGS 1984 UTM Zone 26N WGS 1984, UTM Zone 26 UTM84-26N
North, Meter
WGS 1984 UTM Zone 26S WGS 1984, UTM Zone 26 UTM84-26S
South, Meter
WGS 1984 UTM Zone 27N WGS 1984, UTM Zone 27 UTM84-27N
North, Meter
WGS 1984 UTM Zone 27S WGS 1984, UTM Zone 27 UTM84-27S
South, Meter
WGS 1984 UTM Zone 28N WGS 1984, UTM Zone 28 UTM84-28N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 28S WGS 1984, UTM Zone 28 UTM84-28S
South, Meter
WGS 1984 UTM Zone 29N WGS 1984, UTM Zone 29 UTM84-29N
North, Meter
WGS 1984 UTM Zone 29S WGS 1984, UTM Zone 29 UTM84-29S
South, Meter
WGS 1984 UTM Zone 30N WGS 1984, UTM Zone 30 UTM84-30N
North, Meter
WGS 1984 UTM Zone 30S WGS 1984, UTM Zone 30 UTM84-30S
South, Meter
WGS 1984 UTM Zone 31N WGS 1984, UTM Zone 31 UTM84-31N
North, Meter
WGS 1984 UTM Zone 31S WGS 1984, UTM Zone 31 UTM84-31S
South, Meter
WGS 1984 UTM Zone 32N WGS 1984, UTM Zone 32 UTM84-32N
North, Meter
WGS 1984 UTM Zone 32S WGS 1984, UTM Zone 32 UTM84-32S
South, Meter
WGS 1984 UTM Zone 33N WGS 1984, UTM Zone 33 UTM84-33N
North, Meter
WGS 1984 UTM Zone 33S WGS 1984, UTM Zone 33 UTM84-33S
South, Meter
WGS 1984 UTM Zone 34N WGS 1984, UTM Zone 34 UTM84-34N
North, Meter
WGS 1984 UTM Zone 34S WGS 1984, UTM Zone 34 UTM84-34S
South, Meter
WGS 1984 UTM Zone 35N WGS 1984, UTM Zone 35 UTM84-35N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 35S WGS 1984, UTM Zone 35 UTM84-35S
South, Meter
WGS 1984 UTM Zone 36N WGS 1984, UTM Zone 36 UTM84-36N
North, Meter
WGS 1984 UTM Zone 36S WGS 1984, UTM Zone 36 UTM84-36S
South, Meter
WGS 1984 UTM Zone 37N WGS 1984, UTM Zone 37 UTM84-37N
North, Meter
WGS 1984 UTM Zone 37S WGS 1984, UTM Zone 37 UTM84-37S
South, Meter
WGS 1984 UTM Zone 38N WGS 1984, UTM Zone 38 UTM84-38N
North, Meter
WGS 1984 UTM Zone 38S WGS 1984, UTM Zone 38 UTM84-38S
South, Meter
WGS 1984 UTM Zone 39N WGS 1984, UTM Zone 39 UTM84-39N
North, Meter
WGS 1984 UTM Zone 39S WGS 1984, UTM Zone 39 UTM84-39S
South, Meter
WGS 1984 UTM Zone 40N WGS 1984, UTM Zone 40 UTM84-40N
North, Meter
WGS 1984 UTM Zone 40S WGS 1984, UTM Zone 40 UTM84-40S
South, Meter
WGS 1984 UTM Zone 41N WGS 1984, UTM Zone 41 UTM84-41N
North, Meter
WGS 1984 UTM Zone 4185 WGS 1984, UTM Zone 41 UTM84-41S
South, Meter
WGS 1984 UTM Zone 42N WGS 1984, UTM Zone 42 UTM84-42N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 42S WGS 1984, UTM Zone 42 UTM84-42S
South, Meter
WGS 1984 UTM Zone 43N WGS 1984, UTM Zone 43 UTM84-43N
North, Meter
WGS 1984 UTM Zone 43S WGS 1984, UTM Zone 43 UTM84-43S
South, Meter
WGS 1984 UTM Zone 44N WGS 1984, UTM Zone 44 UTM84-44N
North, Meter
WGS 1984 UTM Zone 44S WGS 1984, UTM Zone 44 UTM84-44S
South, Meter
WGS 1984 UTM Zone 45N WGS 1984, UTM Zone 45 UTM84-45N
North, Meter
WGS 1984 UTM Zone 45S WGS 1984, UTM Zone 45 UTM84-45S
South, Meter
WGS 1984 UTM Zone 46N WGS 1984, UTM Zone 46 UTM84-46N
North, Meter
WGS 1984 UTM Zone 46S WGS 1984, UTM Zone 46 UTM84-46S
South, Meter
WGS 1984 UTM Zone 47N WGS 1984, UTM Zone 47 UTM84-47N
North, Meter
WGS 1984 UTM Zone 47S WGS 1984, UTM Zone 47 UTM84-47S
South, Meter
WGS 1984 UTM Zone 48N WGS 1984, UTM Zone 48 UTM84-48N
North, Meter
WGS 1984 UTM Zone 48S WGS 1984, UTM Zone 48 UTM84-48S
South, Meter
WGS 1984 UTM Zone 49N WGS 1984, UTM Zone 49 UTM84-49N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 49S WGS 1984, UTM Zone 49 UTM84-49S
South, Meter
WGS 1984 UTM Zone 50N WGS 1984, UTM Zone 50 UTM84-50N
North, Meter
WGS 1984 UTM Zone 508 WGS 1984, UTM Zone 50 UTM84-50S
South, Meter
WGS 1984 UTM Zone 51N WGS 1984, UTM Zone 51 UTM84-51N
North, Meter
WGS 1984 UTM Zone 518 WGS 1984, UTM Zone 51 UTM84-51S
South, Meter
WGS 1984 UTM Zone 52N WGS 1984, UTM Zone 52 UTM84-52N
North, Meter
WGS 1984 UTM Zone 528 WGS 1984, UTM Zone 52 UTM84-52S
South, Meter
WGS 1984 UTM Zone 53N WGS 1984, UTM Zone 53 UTM84-53N
North, Meter
WGS 1984 UTM Zone 53S WGS 1984, UTM Zone 53 UTM84-53S
South, Meter
WGS 1984 UTM Zone 54N WGS 1984, UTM Zone 54 UTM84-54N
North, Meter
WGS 1984 UTM Zone 54S WGS 1984, UTM Zone 54 UTM84-54S
South, Meter
WGS 1984 UTM Zone 55N WGS 1984, UTM Zone 55 UTM84-55N
North, Meter
WGS 1984 UTM Zone 558 WGS 1984, UTM Zone 55 UTM84-55S
South, Meter
WGS 1984 UTM Zone 56N WGS 1984, UTM Zone 56 UTM84-56N

North, Meter
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Coordinate Systems for UTM WGS 1984 (continued)

tude, Degrees

SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 UTM Zone 56S WGS 1984, UTM Zone 56 UTM84-56S
South, Meter
WGS 1984 UTM Zone 57N WGS 1984, UTM Zone 57 UTM84-57N
North, Meter
WGS 1984 UTM Zone 57S WGS 1984, UTM Zone 57 UTM84-57S
South, Meter
WGS 1984 UTM Zone 58N WGS 1984, UTM Zone 58 UTM84-58N
North, Meter
WGS 1984 UTM Zone 58S WGS 1984, UTM Zone 58 UTM84-58S
South, Meter
WGS 1984 UTM Zone 59N WGS 1984, UTM Zone 59 UTM84-59N
North, Meter
WGS 1984 UTM Zone 59S WGS 1984, UTM Zone 59 UTM84-59S
South, Meter
WGS 1984 UTM Zone 60N WGS 1984, UTM Zone 60 UTM84-60N
North, Meter
WGS 1984 UTM Zone 60S WGS 1984, UTM Zone 60 UTM84-60S
South, Meter

World

Coordinate Systems for World
SHP Coordinate System MWEF Coordinate System CS Code
WGS 1984 WGS84 datum, Latitude-Longi- LL84
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